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redakecyjne monitory, dnie coraz dluzsze a tym samym
coraz wiecej czasu. Mam nadzieje, ze cho¢ w czeSci wy-
pelni go Wam lektura nowego - 9 juz z kolei - numeru
Dragonii.

Jest to numer Swiateczny - korzystajac z tego przywi-
leju chcialbym wraz z calym zespolem zlozy¢ Wam
Drodzy Czytelnicy najlepsze zyczenia: tradycyjnie,
duzo zdrowia i pogody ducha oraz pociechy z waszych
systemoéw operacyjnych spod znaku pingwina.

W przerwie miedzy kompilacja wielkanocnego jajeczka
a kesem mazurka proponuje zaglebi¢ sie w lekture
kolejnych artykuléw - a W biezacym numerze jak za-
wsze wiele niespodzianek: nasz dzielny Borimir
(wprowadzajacy Was wytrwale w arkana jezyka c++)
zorganizowal konkurs programistyczny ze wspaniala
nagrodg ufundowana przez firme Mandriva; godny
uwagi jest takze bardzo ciekawy artykul Oli, ktora opi-
sala jak ze starego sprzetu uczyni¢ sprawny i wygodny
terminal linuksowy. Jezeli kto§ jest zapalonym
elektronikiem, to koniecznie musi zapozna¢ sie z ar-
tykulem Maéka pod - jakze wyrazistym - tytulem
"Eagle - niezbednik elektronika". W tym miesiacu spo-
ro przeczytamy tez o grafice i renderingu 3D m.in:
Ascii-art, tutoriale Gimp-a czy druga cze$¢ przygod z
Kpovmodelerem.

W tym krétkim wstepniaku uchylitem oczywiscie jedy-
nie rabka tajemnicy, spragnionych informacji zapra-
szam do przeczytania calo$ci.

Zycze milej lektury.

Wasz Smok Naczelny
Piotr Krakowiak ,dragon”

Wszystkie materiaty sa objete prawem autorskim (na zasadach
licencji Creative Commons). Nie ponosimy odpowiedzialnosci za
tres¢ ogtoszen. Nazwy firm, nazwy handlowe i znaki towarowe,
jesli zostaty zostaty uzyte w publikacji, to jedynie w celach
informacyjnych i sa wtasnoscia poszczegdlnych podmiotéw.
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PRZY KAWIE ...

SYSTEM PROGRAMOWANIE

SOFTWARE

Przyczyny propagaciji btedow
do stabilnych wersji Linuksa

Nie bedzie to odkrywczym stwier-
dzeniem jak napisze, ze w Linuksie jest
duzo btedow. Jednak skad sie one kon-
kretnie biorg i jak mozna zapobiegac
ich propagacji do stabilnych wersji sys-
temu? Na to pytanie postaram sie od-
powiedzieC w ponizszym artykule.

Na poczatku musimy sobie odpowiedzie¢ na proste
pytanie — co to jest blad w programie? Blad w
programie jest niezamierzong (zdarzajg sie przypad-
ki, ze zamierzong) pomytka programisty, ktorej skut-
kiem jest nieprawidlowe dzialanie programu. To
nieprawidlowe dzialanie moze sie objawia¢ na kilka
réznych sposobow:

zawieszanie sie programu

podawanie niepoprawnych wynikéw obliczen
mozliwo$§¢ przejecia kontroli nad programem przez
wlamywacza

zafalszowywanie/uszkadzanie danych wej$ciowych
i/lub wyjéciowych

niewydajne/nieefektywne algorytmy

wycieki pamieci, sytuacje wyScigowe etc.

Blad moze wynikaé¢ zaréwno z pomylki podczas pisa-
nia kodu zr6dlowego programu, jak i na etapie plano-
wania jego modelu. Zdarzajg sie réwniez sytuacje, w
ktorych blad powstaje za sprawg niepoprawnego
dzialania narzedzi sluzacych do kompilacji
programu.

Bledy, ktore powstaja na etapie pisania kodu zrédlo-
wego, sa czesto duzo latwiejsze do wyeliminowania
niz te, ktére powstaja na etapie planowania modelu
programu. NiewlaSciwe decyzje podjete w tej fazie
moga powodowac wystepowanie bardzo trudnych
do wyeliminowania bledow.

Jakie sg gléwne przyczyny powstawania btedéw w Li-
nuksie? Zasadnicza przyczyna jest to, ze jest to
projekt duzy i skomplikowany, dlatego wiekszosé
ludzi pracujacych nad systemem skupia sie na swo-
ich ulubionych podsystemach, ktére sa im dobrze
znane. Problem pojawia sie wtedy, gdy kto$ prébuje
zmodyfikowaé¢ kod, ktérego dobrze nie zna i do
konca nie rozumie. Dlatego tez za spora cze$é
bledéw sg odpowiedzialni ludzie, ktorzy Linuksem
zajmuja sie dorywczo.

Kolejna przyczyna jest co§ co sie nazywa Nowy
Model Rozwoju (http://www.stardust.we-

bpages.pl/ltg/wiki/index.php/Proces_rozwoju-
_j%C4%85dra_Linux). Dawniej Linux by} rozwijany
na zasadach podobnych do tych, na jakich jest rozwi-
jane normalne oprogramowanie:

wydanie wersji stabilnej i usuwanie bledéw, ktore
sie do niej przedostaly (np. wersje 2.2.x)

cykl rozwojowy, w ktéorym dodawano nowg funkcjo-
nalno$é, nastepnie prdoba stabilizacji (np. wersje
2.3.X)

kolejne wydania stabilne (np. wersje 2.4.x)

Jednak od wersji 2.6.8 model rozwoju ulegl zmianie
i teraz wyglada tak (na przykladzie wersji 2.6.20 i
2.6.21):

wydanie wersji stabilnej 2.6.20, nastepnie sa publi-
kowane poprawki oznaczane jako 2.6.20.x

praca nad nowa wersja, dodawanie nowej funkcjo-
nalnoSci — 2.6.20-gitX (przewaznie okolo dwbdch
tygodni)

zakonczenie prac nad wersja rozwojowa,
poczecie cyklu stabilizacyjnego — 2.6.21-rcX
wydanie stabilnej wersji 2.6.21

Taki przyspieszony model rozwoju ma swoje wady i
zalety. Do wad mozna zaliczy¢ to, ze postepuje on
naprawde bardzo szybko, wiec duzo bledéw moze
przej$t z wersji rozwojowej do stabilnej. Do zalet po-
winni§my zaliczy¢ to, ze nie trzeba czeka¢ na nowa
funkcjonalnosé przez dlugi okres czasu (dawne wer

roz-
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sje niestabilne byly rozwijane bardzo dlugo, a pierw-
sze wersje stabilne przewaznie trudno bylo za takie
uznacd).

Jaka jest przyczyna wprowadzania w Linuksie
bledéw zwiazanych z bezpieczenstwem systemu? W
doskonatej ksigzce ,,Secure Programming for Linux
and Unix HOWTO” David A. Wheeler wymienil
kilka powoddéw (http://www.dwheeler.com/secure-
programs/Secure-Programs-HOWTO.html#WHY-
WRITE-INSECURE), dla ktérych w programach po-
wstaja bledy, ktére moga zostaé wykorzystane przez
wlamywaczy. Ze swojej strony dorzuce tylko jeden
powdd, ktory nie znalazl sie na tej liscie — mala ilo$¢
odpowiednich programéw (lub ich mala skuteczno-
§¢) ulatwiajacych wykrywanie potencjalnych luk.

Deweloperzy Linuksa przywiazuja bardzo duze
znaczenie do jakosci kodu. Przed zgloszeniem do
przegladu nowego kodu, deweloper powinien upew-
ni¢ sie, ze spelia on wszystkie wymogi wymienione
w Documentation/SubmitChecklist. Nastepnie kod
jest czytany przez innych deweloperéw, ktorzy zgla-
szaja swoje uwagi — najczesciej odnoénie:

stylu kodowania — styl kodowania w Linuksie powi-
nien by¢ jednolity — jest to bardzo wazna sprawa,
poniewaz ulatwia czytanie i rozumienie kodu
(mozna sie z nim zapoznaé czytajac Documenta-
tion/CodingStyle)

zastosowanych algorytméw — kazdemu zalezy na
tym, aby byly one jak najwydajniejsze

poprawnosSci i przejrzystosci struktur danych — nie
ma gorszej rzeczy, niz nieprzemys$lane struktury
danych

W zasadzie trudno jest okresli¢, jaka konkretnie
cze$¢ bledow (lub potencjalnych bledow) jest eli-
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minowana na etapie przegladania kodu.

Kolejnym krokiem jest testowanie kodu w drzewie
danego podsystemu lub -mm, gdzie jest on sprawdza-
ny pod wzgledem wspoélgrania z innymi czeSciami
jadra systemu. Jest to bardzo wazny etap, poniewaz
w nim powinny zostaé wylapane wszystkie powa-
zniejsze bledy. Nastepnie kod jest wlaczany do rozwo-
jowej wersji drzewa Linusa i tam nastepuje
ostateczna proba jego stabilizacji.

Wlaczenie kodu do Linuksa nie jest takie proste —
musi on spelnia¢ narzucone standardy. Najczesciej
nastepuje to za posSrednictwem tak zwanej ,sieci za-
ufania” - kod jest wlgczany do drzewa danego podsys-
temu i dopiero z niego trafia do mainline. Przyczyna
takiego stanu rzeczy jest to, ze Linus Torvalds nie
ma czasu czytac kazdej wprowadzanej poprawki i wy-
chodzi z zalozenia, ze opiekunowie podsystemow
wiedza lepiej jak powinny one wygladac¢ oraz, ze
wlaczone do nich latki zostaly juz odpowiednio prze-
testowane.

Proces dbania o jako$¢ kodu w Linuksie jest bardzo
rygorystyczny — duzo bardziej niz w innych projek-
tach. Dlaczego wiec do wers;ji stabilnych przedostaje
sie tak duzo bledow? Ostatnia poprawka ,stable”
2.6.20.2 sklada sie z ponad stu latek poprawiajacych
konkretne problemy.

Odpowiedz jest bardzo prosta — niewystarczajaca ilo-
$¢ 0sOb posSwieca czas na testowanie i poprawianie
bledéw w nowej funkcjonalnoSci.

Niektorzy uwazaja, ze remedium na te problemy po-
winien by¢ powrét do starego modelu rozwoju, jed-

nak ma on bardzo powazne wady:

na nowa funkcjonalno$¢ trzeba czekaé bardzo dlugo
(ostatni duzy cykl rozwojowy — 2.5.x - trwal ponad
dwa lata!)

deweloperzy ponosza dodatkowe koszty czasowe
zwigzane z przenoszeniem nowej funkcjonalnosci
do stabilnych jader dystrybucyjnych — ten czas
mogliby poswieci¢ na jej tworzenie, poprawianie
bledow etc.

dlugi czas potrzebny na stabilizacje po dlugim cyklu
rozwojowym

Jak wida¢ nowy model rozwoju ma znaczne zalety,
jednak bez wystarczajacej ilosci ludzi testujacych
wydania rozwojowe nie bedzie sie sprawdzal. Spra-
wa jest bardzo skomplikowana, poniewaz dewelope-
rzy nie moga poprawia¢ bledow, o ktorych istnieniu
nie wiedza. Wiekszoé¢ probleméw wychodzi dopiero
wowczas, gdy inni ludzie zaczynaja uzywac¢ danego
kodu. Sytuacja moze sie pogorszy¢ do tego stopnia,
ze nowe stabilne wersje Linuksa beda dzialaly do-
brze tylko na maszynach o zblizonej konfiguracji do
tych, na jakich byly testowane ich wersje rozwojowe.

Dobrym rozwigzaniem, obok zwiekszenia liczby
osob testujacych kod, moze by¢ zmniejszenie szyb-
koéci wprowadzania zmian. Jednak czy naprawde
tego chcemy? Z jednej strony zahamowanie rozwoju
Linuksa moze mie¢ bardzo pozytywny wplyw na je-
go stabilnoé¢, z drugiej strony trzeba sie liczy¢ z
tym, ze wszystkie potrzebne nowe funkcje beda
wchodzi¢ do niego z coraz wiekszym op6znieniem.
Wszystkich zainteresowanych zmiang tego stanu
rzeczy zapraszam do wspolpracy oraz dyskusji na
naszej licie http://groups.google.com/group/linux-
testers-group-pl . m
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LTSP - cienki klient o grubych mozliwosciach

Ciggta pogon za coraz piekniejszym,
szybszym, bardziej rozbudowanym sys-
temem sprawia, ze obecnie komputery
bardzo szybko uwazane sg za przesta-
rzate, a PC-ty okofo 8-letnie to juz prak-
tycznie ztom. A gdyby zreaktywowad
takie maszyny: umozliwi¢c komfortowg
prace w jednym z najbardziej popular-
nych Srodowisk graficznych w rodzaju
KDE czy Gnome i petnowymiarowym
systemie? Mrzonka? Niekoniecznie...

Cudow oczywiScie nie ma, na komputerze PII Suse
czy Mandrivy nie zainstalujemy, jednak LTSP — Li-
nux Terminal Server Projekt — umozliwia wygodna
prace na takim sprzecie. Jak to mozliwe? LTSP to
projekt umozliwiajacy podlaczenie do jednego silne-
go komputera-serwera wielu slabych terminali w
roli tzw. cienkiego klienta. Minimalne wymagania
stawiane takiemu terminalowi sa wrecz $miesznie
mate [1], dzieje sie tak dlatego, gdyz pracuje on w
architekturze klient-serwer [2] i wszystkie dzialania
tak na prawde wykonywane sa na serwerze a
maszyna kliencka shlizy jedynie do wizualizacji
wynikow.

Do poprawnego funkcjonowania serwera LTSP po-

trzebujemy dzialajacych ustug DHCP, NFS, TFTP
oraz XDMCP (w przypadku, jeéli chcemy uzywac
Srodowiska graficznego — a my oczywiScie chce-
my...) oraz — jakze by inaczej — samego LTSP.
Whbrew pozorom instalacja i poprawna konfiguracja
nie jest weale tak przerazajaca, jak na pierwszy rzut
oka sie wydaje — autorowi zajela dokladnie 2 dni. A
wiec do dziela.

Infrastruktura na ktérej przeprowadzono ponizsze
operacje:

Serwer LTSP (zwany dalej po prostu serwerem): lap-
top (wiem, ze zaden normalny czlowiek nie robi ser-
wera na laptopie, ale c6z...) o parametrach: 512MB
ram, CPU 1.86GHz, z zainstalowanym systemem
Debian Etch.

Klient a: PC: 256MB ram CPU 1.2GHz

Klient b (z uwagi na uszkodzona stacje dyskietek wy-

Static IP
192.168.2.5

Ji— SCTV'e" LTSP
3

Rys. 1 Schemat wykorzystanej sieci

stepuje dopiero w ostatnim akcie): PC: 128 MB ram,
CPU 300MHz (jak widaé, jest w wiekszej mierze
prawdziwym ,cienkim klientem” niz wcze$niejszy i
poczatkowo wszelkie dzialania mialy wlasnie jego
dotyczy¢, ale niespodziewanie okazalo sie, ze wia-
$nie ta stacja dyskietek...)

Ruter sprzetowy z mozliwoscig wytaczenia DHCP.

W Debianie jest o tyle wygodnie, Ze instalacja
pakietu ltsp-server-standalone doinstalowuje au-
tomatycznie pozostate brakujace ustugi — jak jest w
innych dystrybucjach: nie wiem. Tak wiec instaluje-
my rzeczony pakiet, a oprocz tego takze ltsp-utils
(przydatne do pézniejszej konfiguracji LTSP).

Fakt powyzszej instalacji nie znaczy wcale, ze caly
serwer LTSP jest juz zainstalowany — tego dokonuje-
my za pomocg ltspadmin, ktory Sciaga odpowiednie
paczki z repozytorium.

Uruchamiamy wiec:

#ltspadmin

i dokonujemy instalacji ze zdalnego repozytorium:
po odpowiedzeniu na kolejne pytania przechodzimy
do wyboru interesujacych nas pakietow — proponuje
zainstalowaé wszystkie.

Scigganie danych troche potrwa, wiec w miedzycza-
sie zajmiemy sie konfiguracja ustug.

DHCP

Podobno najtrudniejszy etap — dlatego pojdzie na
pierwszy ogien. Po pierwsze wylaczamy na ruterze
sprzetowym dzialajace dotad DHCP, poniewaz teraz
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O olka@pingwin: ~ - Powloka - Konsola

Sesfa Edyga Widok, Zakfadki Ustawienia Fomoc

o | B Powioka

O olka@pingwin: - - Powloka - Konsola

Sesfa Edycja  Widok, Zakfadli Ustawienia Pomoc

== | W Powioka

Rys. 2 Kolejne kroki instalacji LTSP

jego role ma pelié serwer (by¢ moze da sie tak skon-
figurowa¢ usluge, by mogta wspoldziala¢ z DHCP na
ruterze, ale ja nie mam pojecia czy/jak to zrobié).
Oczywiécie sam serwer musi mieé state IP (przyczyn
nie trzeba chyba wyjasnia¢). Konfiguracje serwera

PROGRAMOWANIE
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DHCP mozemy przeprowadzi¢ na dwa sposoby: od
poczatku do konca wlasnorecznie (np korzystajac ze
wskazowek [3] lub [4]) lub tez skorzystac¢ z pomocy
Itspefg. Autor przetestowal oba sposoby i osobom
nieobeznanym w konfiguracji DHCP poleca jednak
skorzystanie z automatycznego ustawienia za po-
moca ltspefg (jako sposob, ktory z reguly dziala...).
Po wygenerowaniu pliku dhcp.conf (jesli w katalogu
/ete/dhep3/ istnieje juz taki plik, konfigurator zapi-
sze nowy plik jako dhcp.conf.sample) koniecznie na-
lezy sprawdzi¢ poprawno$¢ wygenerowanych
danych.

W moim przypadku zmienilam adres serwera DNS,
jako zZe nie posiadam wlasnego, oraz nazwe domeny.
A takze jeden nader istotny parametr, ale o tym
dalej...

DHCP dziala, zakladamy, iz poprawnie (prawda, jak
zawsze, wyjdzie w praniu).

NFS

Do poprawnego dzialania wymagana jest edycja pli-
ku /etc/exports, mozna zrobi¢ to wlasnorecznie (np
wg poradnika [3]) albo automatycznie za pomoca
Itspcfg — efekt w obu przypadkach jest identyczny:
Jopt/ltsp 192.168.2.0/255.255.255.0(ro,no-
_root_squash,sync)

/var/opt/ltsp/swapfiles
192.168.2.0/255.255.255.0(rw,no_root_squ-
ash,async)

TFTP

Nie wymaga - przynajmniej tak wynika z
wszystkich dostepnych poradnikéw - zadnych za-
biegobw poza uruchomieniem go w chrootowanym
srodowisku (jednak sytuacja taka jest domy$lna —
przynajmniej w Debianie). Jedyne co nalezy zrobié,
to odkomentowaé odpowiedni wpis w pliku /etc/in-
etd.conf

XDMCP

Wymaga obecnosci w systemie jednego z menadze-
row logowania, czego niestety obejéc sie nie da. Au-
tor — bedacy zdecydowanym i zagorzalym
przeciwnikiem takich wynalazkéw — ciezko przezyt
ten fakt, ale chcac — niechcac zainstalowal w koncu
KDM.

Aby mozliwe bylo zdalne logowanie z wykorzysta-
niem kdm, trzeba wyedytowa¢ dwa pliki
/ete/kde3/kdm/kdmrec: tutaj w sekeji [Xdmep]
zmieniamy Enable=false na: Enable=true

oraz w /etc/kde3/kdm/Xaccess definiujemy zdalny
dostep; autor zdecydowal sie na:

* #any host can get a login win-
dow

Ponad to niezbednym jest zezwolenie na zdalne lo-
gowanie do serwera syslog. W tym celu w pliku
/etc/default/syslogd ustawiamy:

SYSLOGD="-r"

W miedzyczasie niezbedne pliki LTSP z pewno$cia
zdazyly sie juz zainstalowaé, wiec pozostalo tylko
skonfigurowanie samego LTSF. Konfiguracja jest
niezwykle prosta a zarazem elastyczna. Jesli zainsta-
lowaliSmy LTSP w domyS$lnej lokalizacji, edytujemy
plik /opt/ltsp/i386/etc/lts.conf. W pliku tym znaj-
duje sie cala konfiguracja naszego terminala (ter-
minali). Przed jego edycja bardzo dobrze jest
zapozna¢ sie z plikiem lts.conf.readme, w ktéorym
bardzo przystepnie opisane sa dostepne opcje. Lek-
tura tego pliku pozwoli nam stwierdzié, iz mozliwe
sa trzy podstawowe typy sesji: telnet, startx oraz
shell (a takze rdesktop — nie testowane jednak przez
autora). Powyzsze typy sesji zastgpily uzywany we
wezedniejszych wersjach LTSP  parametr RUN-
LEVEL (co trzeba mie¢ na uwadze czytajac manuale
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dostepne w internecie, gdyz z reguly omawiaja one
jeszcze konfiguracje zawierajaca wlasnie RUN-
LEVEL)

TELNET - telnet jak to telnet, omawia¢ go raczej
nie trzeba, umozliwia prace wylacznie w trybie tek-
stowym;

STARTX - praca w trybie graficznym, niezbedna
jest poprawna konfiguracja menadzera logowania;
SHELL — uruchamia powloke NA TERMINALU (a
nie na serwerze), stad przydatno$c tylko do celow
diagnostycznych.

Oprocz typu sesji zdefiniowaé mozemy dodatkowe
parametry umozliwiajace np. korzystanie z lokal-
nych urzadzen (drukarka, cdrom, karta dzwiekowa
itp), dostosowujace konfiguracje do posiadanego
sprzetu (rozdzielczo$¢, parametry monitora) czy tez
wykorzystanie innych serweréw poza LTSP (nfs, dns
itp). Wszystkich parametréw jest niezwykle duzo, a
sg one bardzo przystepnie opisane w pliku readme,
wiec nie ma wiekszego sensu przytaczac ich tutaj.
Nasz plik konfiguracyjny wyglada tak:

[Default]
SERVER =192.168.2.5
XSERVER = auto

X_MOUSE_PROTOCOL ="PS/2"
X_MOUSE_DEVICE ="/dev/psaux"
X_MOUSE_RESOLUTION = 400

X_MOUSE_BUTTONS =3

USE_XFS =N

# SCREEN_ o1 = telnet 192.168.2.5
SCREEN_o01 = startx

jako, ze mam tylko jeden terminal kliencki, wystar-
czy sama sekcja default. W przypadku posiadania
bardziej rozbudowanej sieci o zréznicowanej infra-
strukturze sprzetowej wygodnie jest zdefiniowaé
ogoblne parametry w sekcji default a réznice w sek-
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cjach odpowiadajacych poszczegdlnym terminalom.
W tym miejscu uwaga — jeSli zdecydujemy sie na
przetestowanie wszystkich typow sesji, bardzo praw-
dopodobne, iz niezbednym okaze sie uruchomienie
serwera telnet, jako ze nie jest to juz zbyt popularna
usluga. Sprawdzmy wiec czy dziala i ewentualnie
doinstalujmy ja.

Po stronie serwera wszystko juz skonfigurowali$émy,
pora zabra¢ sie za strone kliencka.

Pierwsze i najwazniejsze to zidentyfikowa¢ posiada-
na karte sieciowa, co umozliwi wybranie odpowied-
niego obrazu Etherboot — mozemy przeprowadzi¢
caly proces bootowania przez sie¢ z wykorzystaniem
bootromu znajdujgcego sie na karcie sieciowa (o ile
nasza karta go posiada), ale samo haslo bylo dla
mnie na tyle przerazajace, ze czym predzej poszu-
kalam alternatywy, ktora okazala sie dyskietka z od-
powiednim obrazem.

Karte zidentyfikowaé¢ mozemy na kilka sposobow:

a) Metoda inzynierska: podchodzimy do problemu
metodycznie — zaopatrzeni w odpowiednich roz-
miaréw Srubokret rozkrecamy komputer, lokalizuje-
my karte sieciowa (dobremu inZynierowi nie
powinno zajaé to wiecej jak kwadrans — gora dwa),
szukamy opisu, ktorego oczywiécie nie wida¢ (biedne-
mu to nawet wiatr w oczy). Sposrdd ktebow kurzu za-
legajacego we wnetrzu obudowy wyciagamy wiec
karte (niefart gdy zintegrowana...) i dokonujemy
identyfikacji organoleptyczne;.

b) Metoda lamerska — czyli ,nic nie wiem, nic nie
umiem, ratunku co ja tu robie”, wlaczamy dowolna
dystrybucje Linuksa — np dyskietkowa i zdobywamy
potrzebne informacje z identyfikacji systemowej (me-
toda calkiem niezla, wymaga jednak: 1. Mozliwos$ci
zbootowania systemu 2. Posiadania Linuksa, 3.Kar-
ty identyfikowanej przez ten system — z niektorymi

kartami ISA sa problemy, z drugiej jednak strony
LTSP to projekt linuksowy, wiec posiadajac taka kar-
te czeka nas sporo zabawy)

¢) Metoda Chucka Norrisa — nic nie musimy sie do-
wiadywa¢, karta sama nam to powie (wzglednie
pamietamy co wkladaliSmy do komputera)

d) Metoda stodkiej blondynki — czyli ,Heniu! pomoéz
kochanie” - chwytamy za komoérke i dzwonimy do
chlopaka, wzglednie zaprzyjaznionego elektronika, a
najlepiej idziemy do niego osobiécie i ze zmartwiona
ming méwimy, ze tylko On moze nam poméc (tutaj
najlepiej zatrzepotaé rozpaczliwie rzesami). Ze
wzgledow oczywistych metoda ta polecana jest jedy-
nie plci niewatpliwie piekne;j...

e) Metoda uzytkownika ,jedynego slusznego sys-
temu” - a co za roOznica jaka karta, Sciggamy
wszystko, w koncu ktory$ obraz zadziala...

Wybér preferowanej metody pozostawiam czytel-
nikowi, ja zdecydowalam sie na metode b... Z uwagi
na fakt, ze komputer pelnigcy role terminala tak na
prawde nie byl bezdyskowy - moze nie
najéwiezszych parametréw, ale tez i nie ostatni pada-
lec (blizsze parametry: patrz poczatek artykuhu,
klient a ), po prostu uruchomiony zostal zainstalo-
wany tam Linux, ktéry dostarczyl ponizszych infor-
macji:

# Ispci -n

00:00.0 0600: 1106:3099

00:01.0 0604: 1106:b099

00:0a.0 0200: 10ec:8139 (rev 10)

00:10.0 0c03: 1106:3038 (rev 80)

00:10.1 0c03: 1106:3038 (rev 80)

00:10.2 0c03: 1106:3038 (rev 80)

00:10.3 0c03: 1106:3104 (rev 82)

00:11.0 0601: 1106:3177

00:11.1 0101: 1106:0571 (rev 06)
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00:11.5 0401: 1106:3059 (rev 50)

00:12.0 0200: 1106:3065 (rev 74)

01:00.0 0300: 10de:0181 (rev a2)

Karty sieciowe to klasa 0200. Jak wida¢ nasz kompu-
ter ma dwie takie karty:

00:0a.0 0200: 10ec:8139 (rev 10)

00:12.0 0200: 1106:3065 (rev 74)

teraz przydaloby sie zidentyfikowaé te karte, ktora
bedzie uzywana. Jako, ze pierwsza cze$¢ PCI ID iden-
tyfikuje producenta — a jak widzimy wiekszo$¢ pod-
zespolow ma tego samego producenta — wnosié
nalezy, ze karta z kodem producenta 1106 to karta
zintegrowana (i tak jest w istocie). My postugiwaé
sie bedziemy dolozong karta Realteka : 00:0a.0
0200: 10ec:8139 (rev 10).

Wchodzimy na strone [5] i generujemy odpowiedni
obraz dyskietki. Po zapisaniu go na dysk, tworzymy
oczywiscie dyskietke:

# cat download/eb-5.4.3-rt18139.zdsk > /dev/sda
(lub /dev/fdo, zaleznie od faktycznie posiadanego na-
pedu)

Posiadamy juz dzialajacy serwer LTSP oraz dyskiet-
ke do zbootowania terminala klienckiego. Pora wiec
w zasadzie na ostateczny test.

W tym miejscu nalezy jeszcze zrobi¢ rachunek
sumienia czy

a) stacja kliencka ustawiona jest na bootowanie z dys-
kietki

b) na serwerze nie dziala firewall

szczegblnie punkt b) jest istotny, jako ze dobry fire-
wall (a innego przeciez nie posiadamy) na pewno
nie zezwoli na komunikacje z uruchomionymi wia-
$nie uslugami. A wiec pora albo otworzy¢ wszystkie
niezbedne porty, albo (nie powiem tego glo$no)
wylaczy¢ firewalla na czas testow.

Oczywi$cie wysoce zalecane jest zmodyfikowanie fire-

PROGRAMOWANIE

SOFTWARE

walla — jednak autor (do czego oczywiscie glo$no sie
nie przyzna...) nie potrafil wytropi¢ wszystkich nie-
zbednych portow, wiec nie bedzie tu zgrywac¢ wa-
zniaka. Na pewno trzeba odblokowa¢ port 68 dla
udp (DHCP), 69 dla udp (TFTP), ponadto porty do
zdalnego montowania plikow, teoretycznie infor-
macje o uzywanych portach uzyskamy przez:
pingwin:/home/olka# rpcinfo -p

program wer. proto port

100000 2 tcp 111 portmapper
100000 2 udp 111 portmapper
100003 2 udp 2049 nfs
100003 3 udp 2049 nfs
100021 1 udp 1024 nlockmgr
100021 3 udp 1024 nlockmgr
100021 4 udp 1024 nlockmgr
100005 1 udp 796 mountd
100005 1 tcp 799 mountd
100005 2 udp 796 mountd
100005 2 tcp 799 mountd
100005 3 udp 796 mountd
100005 3 tcp 799 mountd
100024 1 udp 1027 status
100024 1 tcp 4057 status

ale praktycznie to nie wszystko i przy tak skonfigu-

(Untitled) - Wireshark
Hle Edit View Go Capture Analyze Statistics Help

rowanym firewallu uzyskamy jedynie kernel panic z
adnotacja, iz nie udalo sie zamontowa¢ systemu pli-
kow.

Teraz juz na prawde nie da sie dalej odwlekaé tego
momentu i z dreszczykiem emocji sprawdzamy czy
nasze dotychczasowe dzialania przyniosly zamierzo-
ny skutek.

Proponuje jeszcze wlaczyé na serwerze program
Ethereal — bedzie on bardzo pomocny przy ewen-
tualnym tropieniu bledow.

Wkladamy wiec dyskietke do napedu i... czas na
chwile prawdy.

1)Jesli pojawi sie komunikat w rodzaju ,,No adapter
found” - wybraliSmy zly obraz (sukces! Akurat ten
komunikat zostal mi oszczedzony...).

2)Jedli stacja nie uzyska adresu IP — prawdopodob-
nie zZle skonfigurowaliémy DHCP .

3)Jesli uzyskamy komunikat ,syslogd: cannot write

to remote file handler on IP.serwera:514” - nie
umozliwiliémy zdalnego logowania do serwera
syslog.

4)Jesli kernel panic z powodu niemozliwo$ci za-
montowania filesystemu — czy na pewno firewall na
serwerze jest poprawnie skonfigurowany?

==

BESee ol x8 Re»2F2/EE QRN VMEX O

[ Filter: ltftp

ﬂ <k Expression...

Protocol | Info | e

2.569581 192.168.2.5
192.168.2.199

192.168.2.5

152.168.2.199
192.168.2.5
192.168.2.199

12.301890
12.302752

Time | Source |Desn‘natlon
2.523714 192.168.2.199 192.168.2.5 TFTP Read Request, File: /lts/vmlinuz-2.6.16.1-1tsp-1, Transf

Error Code, Code: File not found, Message: File not foun
Read Request, File: /lts/vmlinuz-2.6.16.1-1tsp-1, Transf
Error Code, Code: File not found, Message: File not foun

Rys. 3 Komunikacja TFTP analizowana za pomoca programu Ethereal
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Co jednak jesli proces ladowania systemu zatrzyma
sie w pewnym miejscu i praktycznie nie wiemy dla-
czego? wowczas z pomoca przychodzi program Ethe-
real i tak:

1)Uporczywe proby nawigzania komunikacji ze
strony klienta i brak jakiejkolwiek odpowiedzi ser-
wera sugerujg zbyt szczelny firewall

2)Proby nawigzania komunikacji zakonczone od-
powiedzia ICMP i adnotacjg Destination unreacha-
ble (port unreachable) — hmm, na pewno
skonfigurowali$my te ustuge?

Zaden z tych przypadkéw nie mial miejsca a jednak
proces ladowania zatrzymal sie w pewnym momen-
cie i czekal tak na co§ do skonczenia $wiata. Co sie
okazalo?

Domyélna konfiguracja TFTP w Debianie wskazuje
na katalog:

#tftp dgram  udp wait root
/usr/sbin/in.tftpd /usr/sbin/in.tftpd -s /var/lib/tftp-
boot

za$ ladowany plik znajduje sie w /tftpboot.

Co wiecej! w pliku konfiguracyjnym utworzonym
przez ltspcfg jest blad, okazuje sie, iz podaje on nie-
poprawna wersje jadra.

Nalezy wyedytowa¢ plik /etc/inetd.conf oraz
/ete/dhep3/dhep.conf zgodnie ze stanem faktycz-
nym.

Po ponownym uruchomieniu naszym oczom powi-
nien ukazac sie ekran KDM. System dziala!

Mozemy zalogowac sie na serwer. Jak juz zostalo za-
uwazone na wstepie, wszystkie operacje wykonuje-
my tak na prawde NA SERWERZE, stacja kliencka
stuzy jedynie do wizualizacji naszych poczynan: stad
tez konta, na ktore sie mamy zalogowaé definiujemy
zawczasu na serwerze, tak samo operacja wylacza-
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nia systemu — poweroff wytaczy SERWER a nie klien-
ta (nie pytaé, skad mam takg pewno$c...); stad
godnym rozwazenia jest uniemozliwienie uzytkow-
nikom wykonywania tej operacji (w przypadku me-
nadzera kdm ustawié nalezy w kcontrol->Menadzer
logowania opcje, ze tylko administrator moze zdal-
nie wylaczy¢ komputer).

Dziala najtrudniejsza cze$¢ konfiguracji, mozemy
jeszceze w celach ogoblnoksztalcacych sprawdzié, jak
rzecz sie ma z sesja telnet oraz jak wyglada lokalny
shell.

Rys. 4 Wynik naszych poczynan

Na poczatku zaznaczylam, ze w ostatnim akcie
pojawi sie jeszcze jeden aktor: tajemniczy klient b.
Ot6z: pierwsze proby zbootowania tego komputera
odslonily straszliwa prawde o niesprawno$ci na-
pedu dyskietek, dlatego tez nie zostal on dotad wy-
korzystany. Dzieki uprzejmosci jednego z kolegéw
(tutaj gorgce podziekowania dla XtriXa z forum
unixy.pl) okazalo sie jednak, ze istnieje co$ takiego
jak projekt 2XThinClient Computing Software,

ktéry umozliwia darmowe pobranie obrazu CD[6], z
ktorego zbootowaé mozemy komputer (plyta za-
wiera wiecej mozliwosci, ale dla nas jedynie istot-
nym jest fakt, ze dalo sie obej$¢ problem
uszkodzonej stacji dyskietek).

I to by bylo na tyle, mozna by jeszcze pokusié sie o
uruchomienie lokalnego odtwarzanie dzwieku, dru-
karki, lokalnego cdromu etc, etc... Ale to juz zupe-
Inie inna historia...

Przydatne adresy:

[1lhttp://pl.wikipedia.org/wiki/Linux_Ter—
minal_Server_Project#Minimalne_wymagania_dla-
_terminali

[2] http://pl.wikipedia.org/wiki/Klient-serwer
[3] http://ltsp.mir-
rors.tds.net/pub/ltsp/docs/ltsp-4.1-
en.html#AEN320 - opis instalacji

[4] http://www.gentoolinux.org/doc/pl/ltsp.xml
- opis instalacji w Jezyku polskim dla dystry-
buciji Gentoo

[5] http://www.rom-o-matic.net/5.4.3/ - wygodny
interfejs do generowania bootromdéw

[6] http://www.2x.com/thinclientserver/downlo—
adlinks.htm

Korzystalam oczywiscie jeszcze z wielu, wielu in-
nych Zrodel niekoniecznie zwigzanych bezposérednio
z LTSP. Sam proces dochodzenia do poprawnej kon-
figuracji tez nie byt taki prosty i r6zowy jak mogloby
sie wydawac po lekturze powyzszego tekstu, stad je-
§li zdecydujesz sie na instalacje LTSP, badz przy-
gotowany mna roézne niespodzianki. Jednak
mozliwo§¢é np komfortowego obejrzenia filmu w
Srodowisku KDE na jakim§ padalcu nadajacym sie
praktycznie na zZtomowanie wynagrodzi trudy docho-
dzenia do sukcesu. m
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C++ czesc 8

W numerze tym zajmiemy sie uniami,
strukturami i polami bitowymi. Po
czesci elementy te usprawniajg w pew-
nych sytuacjach programowanie, po
czesci w C++ sg po to, by uproscic prze-
noszenie programdéw napisanych w C,
gdzie byty uzywane o wiele czesciej.
Konstrukcji tych nie bedziemy uzywac
zbyt czesto, ale musimy wiedziec¢
przynajmniej do czego stuzg i jakie jest
ich dziatanie.

Zacznijmy od struktur. Struktura jest konstrukcja
bardzo podobna do klasy, ale domy$lnym sposobem
dostepu do jej skladowych jest public (w klasie jest
to private). W strukturze mozemy réwniez stosowac
metody dostepu private i protected, funkcje sklado-
we, konstruktory, destruktory, przetadowane opera-
tory i skladowe statyczne. Jednym slowem:
wszystko to, co dostepne jest w klasie. Struktur naj-
czedciej uzywa sie w celu tworzenia naprawde
prostych obiektow. Bardzo dobrym przykladem jest
typ obiektu punkt, ktéry moze by¢ przez nas uzywa-
ny w programach graficznych, matematycznych jako
punkt na plaszczyznie ukladu wspoélrzednych:

struct punkt {
int x;
int y;
bi

dla
wszystkich. Struktura wydaje sie tu prostszym i nie-
co przejrzystszym sposobem kodowania, ale to
samo mozna uzyskaé stosujac klase:

Domysélnie obie skladowe sa dostepne

class punkt {
public:
int x;
int y;
bi

Musimy dodac¢ etykiete dostepu public, ale obie kon-
strukcje sa w pelni réwnowazne. Wielu
programistow wyznaje zasade, ze struktury uzywane
sa dla naprawde prostych obiektéw, ktére nie wy-
magaja zadnych dodatkowych usprawnien dostarcza-
nych przez Kklasy. Jednocze$nie struktury sa
powszechnie uzywane w funkcjach systemowych
Uniksa, miedzy innymi dlatego, ze odnosimy sie do
nich z poziomu ANSI C, ktore klas po prostu nie po-
siada.

O wiele ciekawszymi obiektami sa unie. Unie z
definicji umozliwiaja zapisywanie zmiennych w tym
samym miejscu pamieci. Uzywa sie ich w bardziej
skomplikowanych programach w przypadku obiek-

tow, ktore przechowuja wartos$é, ktora traktowaé
mozemy w dwojaki sposéb. Brzmi to troche zawile,
ale okazuje sie bardzo proste. W jednym z pierw-
szych odcinkéw naszego kursu prezentowalem bar-
dzo prosty program, ktéry wypisywal kod ASCII
danego znaku. Stosowaliémy wowczas mechanizm,
ktoéry nazywa sie rzutowaniem np.:

char ¢ = 'a';
cout << int(c) << endl;

Na wyjéciu programu pojawi sie warto$¢ 97. W tym
prostym przykladzie kazaliSmy kompilatorowi spoj-
rze¢ na zmienna znakowa c tak jak byla by to liczba
catkowita int(). Unie pozwola nam rozwiaza¢ powy-
Zszy sposOb w jeszcze inny sposob.

#include <iostream>
using namespace std;
union znakoliczba { // (1)
char znak;
int liczba;
bi

int main(int argc, char *argvl[])
{
znakoliczba zl;//(2)

zl.liczba = 0; //(3)
zl.znak = 'a'; //(4)
cout << "Znak " << zl.znak << " to " <<

zl.liczba << " w zapisie ASCII\n"; //(5)
return 0;

}
Wynik dzialania programu:

Znak a to 97 w zapisie ASCII
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1)Deklaracja unii. Podobna jest do deklaracji klasy
lub struktury, ale w tym przypadku nie oznacza, ze
zawiera dwa elementy - zapis ten moéwi kompila-
torowi, ze raz moze przechowywaé warto$c int raz
char. Obie zmienne odwoluja sie do tego samego ob-
szaru pamieci. Jaki rozmiar ma unia? Ma ona taki
rozmiar, jak najwieksza z wartoSci, ktéra pozwala-
my w niej przechowywac. Jeéli przyjmiemy, ze w na-
szym systemie rozmiar typu int wynosi 4 bajty, a
char 1, to rozmiar unii bedzie wynosi¢ 4 bajty. Dodat-
kowo obie zmienne rozpoczynaja sie w tym samym
miejscu pamieci.

2)Definiujemy jeden obiekt typu znakoliczba.
3)Zerujemy warto$¢ int. Poniewaz obiekt tworzony
jest na stosie moze zawiera¢ $mieci, bez tej operacji
przypisania wynik programu bylby przypadkowy,
przy czym nie bylby to blad.

4)Przypisujemy elementowi znak warto$¢ 'a'. Sklado-
wa znak i liczba odnosza sie do tego samego miejsca
w pamieci, wiec kolejno$¢ przypisan jest w tym przy-
padku istotna. Jesli wykonamy je odwrotnie to 0 nad-
pisze nam warto$¢ 'a’ i w unii przechowywane
bedzie 0 — gdy warto$¢ sprawdzac¢ bedziemy przy po-
mocy skladowej liczba i znak "\0' (czyli null) w przy-
padku skladowej znak.

5)Wypisujemy zawarto$¢ zmiennej typu znakoliczba
raz jako warto$¢ znakowa — otrzymujemy wowczas
'a', a raz jako liczbe — otrzymujemy 97, co od-
powiada warto$ci znaku 'a' w kodzie ASCIIL. Oznacza
to, ze naprawde operujemy na tej samej komorce
pamieci tylko raz uwazajac zapisane w niej dane za
liczbe, a raz jako znak. Rozmiar unii jest taki, jak roz-
miar jej najwiekszego elementu.

Unia oprocz obiektow typéw wbudowanych moze za-

wiera¢ rowniez obiekty przez nas definiowane, ale
istnieje pare ograniczen, o ktéorych musimy
pamietac:

obiekty skladowe nie moga mie¢ konstruktoréw —
jest to logiczne ograniczenie, bo skoro wszystkie
obiekty znajduja sie pod tym samym adresem
pamieci, to jesli po kolei ruszylyby konstruktory to
nadpisywalyby pamieé¢ i wynik bylby niezdefiniowa-
ny;

obiekt skladowy nie moze mieé¢ destruktora z tych
samych powodéw co konstruktora;

obiekt nie moze mieé¢ przeladowanego operatora
przypisania (nie moéowiliSmy jeszcze o tym).

Wewnatrz unii mozemy podobnie jak w klasach i
strukturach uzywac etykiet okreslajacych dostep, ale
tylko private i public. Uzywanie protected nie jest do-
zwolone, bo unie nie moga by¢ dziedziczone. Ponie-
waz unie nie moga by¢ dziedziczone, nie moga tez
posiada¢ funkcji wirtualnych (choé¢ zwykle funkcje
skladowe moga posiadad).

Bardzo ciekawym elementem jezyka sg tak zwane po-
la bitowe. Mozemy ich uzywac by odnosi¢ sie do od-
powiednich bitéw danej zmienne;j.

#include <iostream>
using namespace std;

~
~
[

union pole_bit {
struct {

unsigned bl :

b2 :

b3 :

b4 :

b5 :

b6 :

b7 :

b8 :

PR R R R R R

bi

int liczba;
bi

int main(int argc, char *argv([]) {

pole_bit a; //(2)
for(a.liczba = 0; a.liczba < 32 ; a.licz-
ba++) //(3)

cout << a.b8 << a.b7 << a.b6 << a.bb <<
a.bd << a.b3 << a.b2 << a.bl << " : " << a.licz-
ba << endl; // (4)
}

Wynik dzialania programu (skrocony, bo pelny ma
32 linijki)

00000000 : 0
00000001 :1

00011110 : 30
00011111 : 31

1)Definiujemy unie. Jej skladnikami sg nienazwana
struktura i zmienna typu int. Do tej pory nie tworzy-
lidémy typow nienazwanych. Typy te maja takie same
wlasciwosci jak nazwane, ale poniewaz nie maja na-
zZwy, nie mozemy tworzy¢ przy ich pomocy egzem-
plarzy danego typu. Ten typ jest elementem unii i
nienadanie mu nazwy usprawnia odnoszenie sie do
elementow skladowych. Po prostu bezposrednio po
nazwie egzemplarza unii podajemy nazwe danej
skladowej struktury tak, jakby byla ona bezposred-
nig sktadowa unii, ale w rzeczywisto$ci sg one zebra-
ne w pewng grupe tworzong przez nienazwang
strukture. Dziwny jest rowniez sposéb definiowania
skladowych, po ich nazwie stawiamy dwukropek, a
za nim ilo§¢ kolejnych bitéw, do ktérych przy po-
mocy danej nazwy sie odnosimy. Dla ulatwienia
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wprowadzamy tylko 8 pierwszych bitow. Dzieki
temu, jesli zapiszemy jaka$ liczbe w unii przy po-

mocy skladowej liczba, to nastepnie korzystajac z

obiektow od b1 do b8 mozemy odnosi¢ sie do war-
toéci kolejnych bitéw. Dzieki temu uzyskujemy

prosty i przejrzysty sposob operacji na bitach danej

-

U M,

T/ PowerPack

zmienne;j. powerPack
2)Definiujemy obiekt typu pole_bit. e
3)W petli, zwiekszajac stopniowo wartosé¢ liczby za- Nalezy odpowiedzie¢ na ponizsze trzy pytania i wystaé

pamigtanej w unii, wypisujemy kolejne reprezenta- odpowiedzi na adres konkurs@dragonia.pl.

cje binarne tej liczby.

4)W tym miejscu w bardzo prosty spos6b nakazuje-
my wypisanie kolejnych bitéw. Widzimy, ze po
prostu wypisujemy obiekty skladowe b1 ... b8. Jesli
przyjrzymy sie wynikowi naszego programu, to

Odpowiedzi nalezy wysyta¢ do dnia 25 kwietnia 2007r.
WSsréd prawidtowych odpowiedzi rozlosujemy Mandrakelinux 10.1
PowerPack Advanced.

rzeczywidcie wypisywane wartoSci sa reprezenta- 1.Domy$Inym trybem dostepu do klasy jest:
cjami binarnymi kolejnych liczb z przedziatlu od o a) private
do 31. )
b) public,
Struktury, unie i pola bitowe sg rzadko uzywanymi c) protected;
elementami C++, ale dzieki swoim ciekawym wlasci-
woéciom umiejetnie zastosowane moga znacznie 2.Ktdra grupa operatoréw ma priorytet nizszy od pozostatych:
uproscié rozwigzanie problemu. m a) =, *=, /=, %=, +=, =, <<=, >>=, &=, |=, M=;
b) *, /, %;
C) <, <=, >, >=;

3.Poprawna definicja wskaznika wsk_fun do funkgciji:
int * funkcja(double, char*);

to:

a) int* *wsk_fun (double, char)
b) int* (*wsk_fun)(double, char)
C) int* (*wsk_fun)(double, char*)

- /

dragopja.
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Pierwsze korki w Gambasie

Gambas to jezyk programowania typu
BASIC (Beginner's All-purpose Sym-
bolic Instruction Code). Posiada wiele
cech wspdlnych z Visual Basic jednak
nie jest implementacjg tego dialektu BA-
SlCa. Mimo to rozwija sie odpowiedni
modut, ktéry umozliwia prawie bez-
bolesne przeportowanie programu z VB
na Gambasa.

Projekt Gambas oprocz interpretera, ktory jest nie-
zbedny do uruchomienia aplikacji, tworzy cale Srodo-
wisko programistyczne oraz caly zestaw bibliotek.
W Gambasie mamy dostep do komponentéw do
kompresji poprzez komponenty do baz danych po
kontrolki graficzne.

Instalacja

Z dziwnych powoddéw, mimo ze Gambas jest dostep-
ny w wiekszodci dystrybucji, to niektorzy dystry-
butorzy nie potrafia sobie poradzi¢ z poprawna
budowa paczek. Jednak nie jesteSmy skazani na
samodzielng kompilacje, gdyz wlasciwie skompilowa-
ne paczki mozna znalezé w dziale Download na
stronie http://gambas.sourceforge.net/ . Tak tez
jest z paczkami do Mandrivy. Rob Kudla przy-

gotowal paczki,
ktére mozna bez
problemu zainstalo-
wac.

Dostepne sg jednak
paczki tylko do
Mandrivy 2k6, dla-
tego  uzytkownicy
2k7 powinni stwo-
rzy¢ wymagane do-

gambas-gb-db-mysql
gambas-gh-db-posigresql
gambas-gb-db-sqlite
gambas-gb-eval

gambas-gh-net-curl
gambas-gb-gt
gambas-gb-gt-editor

cambas-gb-qt-ext

wigzanie 2ambas-gb-gt-kde
symboliczne: In -s \gambas-gb-qi-kde-himl

. gambas-gb-sdl
/usr/lib/libgettext- cambas-gh-vb
src-0.14.6.s0 (gambas-gb-xml
/usr/lib/libgettext-  |gambas-ide
Src-0.14.5.50 gambas-runtime
Trzeba réwniez

pamieta¢, by zainstalowa¢ pakiety umozliwiajace
budowanie rpmoéw, gdyz nie sa one domyslnie wy-
magane przez paczki Gambasa a bez niech nie utwo-
rzymy rpméw z programami w Gamasie. Dla
Mandrivy beda to odpowiednio rpm-build, rpm-man-
driva-setup-build i spec-helper.

Po instalacji pozostaje nam tylko wyszuka¢ Gambsa
w menu i go uruchomi¢. Mito$nicy konsoli wpisuja
po prostu gambas.

Podstawy jezyka

Programy w Gambasie piszemy tworzac klasy. Dla
kazdej klasy osobny plik. Niektére z klas mozemy
oznaczy¢ jako Formularze, co umozliwia nam two-

rzenie programow okienkowych. Wyjatkiem od tej
reguly sa moduly, ktore nie sa klasami a zbiorami
funkcji- dostepnymi dla kazdej klasy w naszym
programie. Jednak tworcy Gambasa nie zalecaja
stosowania moduléw, gdyz burzy to obiektowo-
zorientowany sposob programowania.

Dla kazdej kasy mozemy dodawa¢ zmienne lub me-
tody. Zmienne deklarujemy postaci: stowo kluczowe
okres$lajace dostep do zmiennej (PUBLIC lub PRI-
VATE), nazwa zmiennej, stowo kluczowe AS a po

nim nazwa typu zmiennej np.:
PUBLIC zmiennaPubliczna AS Integer
PUBLIC zmiennaPrywatna AS Integer

Dodatkowo kazda zmienna mozna uczyni¢ statycz-
ng, czyli dostepna dla wszystkich obiektow tej klasy
(jest to analogiczne zachowanie jak zmiennych sta-
tic w C++ czy Javie).

Do metod réwniez mozna doda¢ slowo kluczowe
okreslajace dostep do tychze z innych klas (PUBLIC
lub PRIVATE). Dodatkowo mamy dwa gtéwne typy
metod: SUB — nie zwracajaca warto$ci oraz FUNC-

TION — zwracajaca warto$¢ np.:
PUBLIC FUNCTION f (x AS Integer) AS Integer
DIM a AS Integer

a =2
RETURN a*x
END

Jak widaé na powyzszym przykladzie zmienne w me-
todach deklaruje sie nieco inaczej, czyli: stowko
DIM, nazwa zmiennej, stbwko AS i typ zmienne;j.
Nalezy zwroci¢ uwage na to, gdzie deklarujemy swo-
je zmienne w metodzie, gdyz miedzy deklaracjami
nie moga wystepowa¢ zadne inne instrukcje.
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Operator | Opis Przyklad Wynik przykladu stepowac instrukcje sterujace. I
+ Dodaje dwie liczby 243 5 tak; sz'tla for ma naste;puj aca
Odejmuje dwie liczby 23 -1 skladnie: slowo FOR, wyrazenie
* Mnozy dwie liczby 2%3 6 startowe, slowko TO warunek
i Dzieli dwie liczby i.-’]- 0,66666666666T prZerWania peth, Opcjonalnie S}éw_
i ol A . . 2 7
Podnosi do potegi 3 8 ko STEP i wielko$¢ kroku, nastep-
MOD Reszta z dzielenia 2MOD 3 2 nie inStruije PQﬂl Koniec
= Poréwnani 2=13 Fal :
i - oznaczony jest przez stowo NEXT
<> Nie rowne 2<>3 True
np.:
< Mniejsze 2<3 Trye DIM I AS Integer
<= Mniejsze rowne 2e=3 True FOR I = 1 TO 20 STEP 3
> Wigksze 2>3 False PRINT I & " ";
>= Wicksze rowne 25=3 False NEXT
Istnieje tez odmiana tej petli
& Dodawanie dwdch napisow LAAAT & BBB” AAABBB do przegladania tablic i kolek-
cji:
&/ Dodawanie  dwdch  napiséw |, AAA" &/ ,.BBB” AAA/BBB DIM Dict AS NEW Collection
zawierajacych ScieZki. LAAAM &/ LBBB” AAA/BBB DIM Element AS String
AND Ligiczne [ 2AND 3 2 Dict["Blue"] = 3
OR Logiczne lub 20R3 3 Dict["Red"] =1
XOR Alternatywa wyglkuczajaca 2XOR 3 1 Dict["Green"] = 2
FOR EACH Element IN Dict
NOT Operator zaprzeczenia NOT FALSE True PRINT Element :
’
INC Zwigksza o jeden i=2 3 NEXT
INCi , . .
— - Oprocz tych petli sa jeszcze petle
DEC Zmniejsza o jeden i=2 1
DEC | WHILE, DO..WHILE, REPE-
Operatory AT...UNTIL, ktore sa bardzo do-

Niestety w Gambasie niektore operatory maja nieco
inne znaczenia w poréwnniu z tymi znanymi z C++
czy Javy i tak powszechnie znany operator inkremen-
tacji (++) niestety nie wystepuje, w zamian za to jest
operator INC. Natomiast operator " nie oblicza alter-
natywy wykluczajacej (co robi operator XOR) a pod-
nosi do potegi. Ponizsza tabela przedstawia spis
wazniejszych operatordw wraz z objasnieniem ich
dzialania.

Petle, warunki itp.

Jak w kazdym jezyku programowania, musza wy-

brze opisane w dokumentacji i nie ma sensu
przytaczac ich opisu.
Dla porzadku zaprezentujmy jeszcze warunek IF
DIM i AS Integer
i=3
IF i < 5 THEN
PRINT ,Liczba mniejsza od 5"

ELSE

PRINT ,Liczba wieksza od 5"
ENDIF
Stowo kluczowe WITH

Czasami zdarza sie tak, ze tworzymy klase, w niej
obiekty innej klasy, w ktérych tez sa obiekty z
jakimi$ metodami. Aby wywolaé¢ odpowiednia me-

tode nalezaloby zrobi¢ tak:
ObiektKlasy1.0biektKlasyWew.MetodaKlasyWew()
Jezeli w pewnej czeSci kodu wielokrotnie bedziemy
musieli wywolywaé metody klasy wewnetrznej, to
wielokrotnie bedzie trzeba powtarzaé ciag znakow
ObiektKlasy1.ObiektKlasyWew. Co troche zmniejsza
czytelno$é¢ kodu. Problem ten rozwigzuje wlasnie
stowo kluczowe WITH dostarczajac nam bardzo
ciekawa funkcjonalno$¢. Ustala ono lokalnie
znaczenie operatora . (kropka), tak by rozumie¢ go

jako dowotlanie do odpowiedniej klasy np.:

WITH ObiektKlasyl.ObiektKlasyWew
.MetodaKlasyWew ()

END WITH

Pierwszy program

Uzbrojeni w te skromng wiedze na temat skladni,
uruchamiamy $rodowisko programistyczne dostar-
czone wraz z paczka gambas-ide. Po uruchomieniu
Gambasa pojawia sie okno powitalne, dzieki ktére-
mu mozemy utworzy¢ nowy projekt, wybra¢ do
otwarcia poprzedni lub obejrze¢ przyklady. Wybra-
nie Nowy projekt... uruchamia kreator, ktéry po-
prowadzi nas za raczke. Od tak stworzonego
programu mozemy zacza¢ pisaé nasz pierwszy
program.

Srodowisko domyélnie sklada sie z czterech
okienek: okna zarzadzania projektem (okno glowne
Gambasa), okna z wlasciwo$ciami oraz pasek z kon-
trolkami. Wystarczy teraz doda¢ Formularz
(prawym klawiszem myszy na katalogi w oknie glow-
nym Nowy -> Formularz... ) Nastepnie w kreatorze
podajemy takie rzeczy jak to czy ma domy$lnie utwo-
rzy¢ konstruktor, destruktor i czy Formularz jest kla-
sa bazowa. Utworzenie nowego formularza
powoduje otwarcie sie dwoch nowych okienek.
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Pierwsze to wizualizacja okienka, drugie to edytor.
Teraz mozemy polozy¢ na formularzu przycisk (wy-
bieramy Button z paska kontrolek) oraz etykiete (La-
bel). Podwojne Kklikniecie na przycisk powoduje
wygenerowanie funkcji obstugujacych zdarzenie naci-
$niecia przycisku. Calo$¢ powinna wygladaé¢ mniej
wiecej tak:

PUBLIC SUB Buttonl_Click()

Labell.Text = "Saluton Mondo"
END

Mozna uruchomié teraz nasz program zielonym tréj-
kacikiem na pasku narzedzi. Naciéniecie przycisku
w naszym programie spowoduje podmiane tekstu
na etykiecie.

Obstuga zdarzen.

Jak mozna bylo zauwazy¢ w poprzednim przykla-
dzie, metoda obslugujaca zdarzenie ma nazwe w po-
staci NazwaKontrolki_NazwaZdarzenia(). Dzieki
temu mozemy tworzy¢ wlasne funkcje obstugujace in-

-I:IX“

'ﬁ‘} Witaj w programie Gambas!

Gambas

[ Mowy projekt... Przyktady
Automation -

[ Otworz projekt... % KateBrowser I
Ed| scriptin

[> oOstatnie projekty L= pting
Basic

@ Przyklady G slights

Zakoncz % Collection

}E—_g DragNDrop

@o Object =

PROGRAMOWANIE

. s e e .’ T AL SSE T SNy | T | g parasdai — i
ne zdarzenia. Jednak prosciej p.,khp.}.,,eu — : —— ]
jest nacisna¢ prawym Klawi- s VAnxen@EY o 08 EBRRERDEE
szem myszy na wybrany "Z@E@8ssad S [e @ D N

HRArnNEFHOR | =) ] o || &5
1 b - @ stoper ) -
obiekt by wyw olac’ menu - & O o
kontekstowe i wybra¢ z listy & czadanie Zadania _pomoc iClass) TextBox
- &g Formularze T - T
. . . START Minuty Sekundy i (Name) muzyka
odpowiednie zdarzenie. L oot {croup)
H Fwiadomosc N :-51 : iu
. 3 Moduly ¢ =p)
CO dalej? - £3Zasoby Homi®® n o I" < : Y Width 296
. . [JCHANGELDG PUBLIC 5 AS Settings L | odegraj déwiek | Diw :|Esl|gb:: ?:ue
Teraz w zasadzie nalezy tylko 08 ikorke.prg T visle e
sobie wymyS$lic swo6j wilasny Dyikenika.xct PUBLIC co AS String | ° o
ackigroun
program i go zakodowaé w PUBLIC akZad AS Inteo T Zapiss ¥ Usuh " Foreground
: : PUBLIC SUB DiatSec chimo o [ E3SE [ USU G
GambaSIe' Ma_]ac gOtOV’Vy LCDsec.Value = DialSec.Value :‘:n”;;\p L
program w latwy sposob o Drop True
S , Expand False
mozemy przygotowaé od- PBLEE SR i i tharge Tl . .
powiednie paczki do rozpo- \Chmin. Yalun = pialein.Vales Resdonly false
.. ;
wszechniania naszego o oo
programu. W tym celu wy- PUBLIC S8 Start Click() s e
bieramy z menu Projekt -> bialain.Enabled « FALSE
Yz mer ve Sistse. abted - bt
Utworz pakiet instalacyjny... , zegar Enabled = TRUE
. Start.BackCelor = Coler RGB(255, @
co uruchomi nam kreatora, . B

ktory nie zadajac zbyt wielu

zbednych pytan pozwoli utworzy¢ paczki dla Mandri-
vy, SuSe, RedHata czy Debiana. Do uruchomienia na-
szego programu wystarczy zainstalowaé oprocz
naszej paczki jeszcze tylko paczke z interpreterem
(gambas-runtime) i gotowe.

Ogladamy przyktady.

Aby zapozna¢ sie z mozliwoSciami Gambasa mozna
obejrze¢ przyklady dostarczone wraz z calym IDE
Gambasa. Jest ich do$¢ sporo, bo 33, wiec kazdy znaj-
dzie co$ dla siebie. Niestety, przyklady maja dosé¢
skapy komentarz - zeby nie powiedzie¢, ze nie maja
go wcale. Na pocieszenie moge dodac¢ tylko, ze sklad-
nia jest na tyle zrozumiala, ze i bez komentarzy
mozna sobie poradzi¢ ze zrozumieniem dziatania.

~Problem” licencji

Niestety ze wzgledu na fakt, ze Gambas swoje
biblioteki okienkowe oparl o biblioteke QT, jedyna
licencja na jakiej mozemy wydawaé programy uzy-
wajace okienek i napisane w Gambsie jest GPL (chy-
ba, ze wykupi sie odpowiednig licencje od
TrollTecha). ,,Problem” ten ma zosta¢ pos$rednio roz-
wigzany w nastepnym wydaniu Gambasa, gdyz
oprocz komponentéw graficznych korzystajacych z
QT pojawia sie zblizone funkcjonalnoécia wykorzy-
stujace biblioteke GTK. Dzieki temu, ze GTK jest wy-
dawane na licencji LGPL umozliwi to pisanie w
pelni komercyjnych aplikacji pod Gambasem. Hl
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Programowanie

w systemie GNU/Linux

Ten kurs bedzie dotyczy¢ programowa-
nia w Srodowisku systemu operacyjne-
go. Nie dotyczy on tylko systeméw
opartych na jadrze Linux, dotyczy on
ogdblnie systemdéw zgodnych z normg
POSIX - w tym Solaris, rodzina BSD, a
nawet Microsoft Windows 2000 (wy-
maga to pewnych zmian w rejestrze sys-
temu).

Znajomo$¢ samego tylko jezyka programowania nie
wystarcza do napisania bardziej skomplikowanego
programu. Potrzebujemy jeszcze zestawu dodat-
kowych funkcji. Jezyk programowania dostarcza
nam w zasadzie tylko pewnego modelu abstrakcji,
ktoéry powinien umozliwia¢ swobodne realizowanie
projektow. Poniewaz jezyki programowania wy-
sokiego poziomu projektuje sie tak, by byly jak naj-
bardziej przenoéne, unika sie wprowadzania w nich
elementow zaleznych od jakiego$ konkretnego sys-
temu operacyjnego. Z tego powodu to, co dostajemy
razem z ANSI C, jest maksymalnie przenosne, ale jed-
nocze$nie zbyt ogblne by wykorzystywaé wszystkie

mozliwo$ci, ktore drzemia w naszym systemie. Jed-
nym stowem, bez dodatkowych bibliotek i funkeji sys-
temowych nic ciekawego raczej nie zrobimy.

W systemie GNU/Linux znajduje sie wiele funkcji
systemowych i bibliotecznych zwigzanych z sys-
temem i dostarczanych wraz z nim, ktére mozemy
wykorzystywaé w naszych programach. Funkcje te
dajg nam wiele dodatkowych mozliwoéci, jak choéby
obslige systemu plikéw, katalogéw, procesdow czy
sygnalow. Tych funkcjonalno$ci prozno szuka¢ w AN-
SI C. Bez nich napisanie powaznego programu jest
prawie niemozliwe. Postaram sie po kolei przedsta-
wi¢ funkcje systemowe i biblioteczne, ktoére z po-
ziomu ANSI C (oraz réwniez ISO C++) beda mogly
by¢ wykorzystywane w programach.

Zaczniemy od omawiania sposobu obshtugi plikow i
katalogow. WiadomosSci te sg podstawowe i w zasa-
dzie niezbedne do dalszej nauki. Wiele informacji o
funkcjach i odpowiednich strukturach mozna
znaleZ¢ na stronach podrecznika systemowego man.

Od tej pory mdéwigc system mam na mysli systemy
zgodne z normg POSIX i tylko nimi bedziemy sie zaj-
mowac. Nasze programy beda napisane w ANSI C i
kompilowane kompilatorem GCC. Osoby znajace

ISO C++ nie powinny mie¢ zadnego problemu ze
zrozumieniem kodu zrédlowego programéw prezen-
towanych w tym kursie. W miejscach, w ktérych AN-
SI C r6zni sie skladnia lub dzialaniem od ISO C++,
postaram sie wyraznie to zaznaczy¢.

W Linuksie wszystko jest plikiem. W systemach
UNIX wszystko, co znajduje sie w systemie, ma swo-
ja reprezentacje w formie pliku, przy pomocy ktore-
go mozemy odwolywaé sie do urzadzenia czy
zasobu. Plikiem sa zwykle pliki znajdujace sie na
dysku, linki symboliczne do plikow, kolejki FIFO,
gniazda stuzace do komunikacji, katalogi i urzadza-
nia, w tym réwniez dyski twarde, na ktorych zapisu-
jemy nasze pliki. Dzieki temu dostajemy spojny i
przejrzysty interfejs obstugi systemu.

Funkcje uzywane do obslugi wejécia/wyjScia nie sa
funkcjami buforowanymi. Oznacza to, ze nie wy-
korzystuja do swojego dzialania zadnych buforow,
ktére maja za zadanie przyspieszyé¢ ich dzialanie.
System operacyjny jednak w warstwie jadra czesto
stosuje pewne rodzaje buforowania na swoje po-
trzeby.

Podstawowa funkcjg jest funkcja odpowiedzialna za
otwarcie okreSlonego pliku. Funkcja ta przekazuje
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tak zwany deskryptor pliku. Deskryptor pliku jest to
nieujemna liczba calkowita, przy pomocy ktoérej od-
wolujemy sie do otwartego pliku w naszym
programie. W pliku nagléwkowym unistd.h mamy
zdefiniowane trzy deskryptory plikow STDI-
N_FILENO, STDOUT_FILENO, STDER-
R_FILENO. Maja one najczeSciej numery o, 1, 2, ale
dla zapewnienia maksymalnej przeno$nosci powi-
nno sie stosowac wyzej wymienione stale.

#include <sys/types.h>
#include <sys/stat.h>
#include <fecntl.h>

int open (const char *pathname,
mode_t mode) ;

int flags,

Powyzszy zapis bedzie stosowany od tego momentu
zawsze przy podawaniu deklaracji (zwanej réwniez
prototypem funkcji). Oznacza on, ze do Zrodla
programu nalezy przy pomocy dyrektywy preproce-
sora include wstawi¢ trzy pliki nagléwkowe (dodam,
ze linijki zaczynajace sie od #include powinno
umieszczaé sie na samej goérze kodu zrédlowego).
Ponizej znajduje sie deklaracja funkcji wraz z prze-
kazywanymi do niej typami argumentéw. Argumen-
ty =zaznaczone na czerwono s3 opcjonalne.
Rozumiem przez to, ze tylko przy pewnych wywola-
niach funkcji konieczne jest ich podanie.

Funkcja open zwraca warto$¢ catkowita int wieksza
lub réwna o, ktéra jest deskryptorem pliku. Poloze-
nie i nazwe pliku, ktory chcemy otworzy¢ wskazuje
argument pathname. W przypadku btedu, np. gdy po-
dana przez nas $ciezka pathname nie odnosi sie do
poprawnego pliku w systemie lub nie mamy prawa
do czytania tego pliku, zwraca warto$¢ -1.

Jesdli wywolujemy funkcje open z opcja O_CREAT

go zamknaé przy pomocy funk-

cji close.

#include <unistd.h>

Opcje wymagane flags:

O_RDONLY tylko do odezytu
O_WRONLY tylko do zapisu
O_RDWR do odezytu i zapisu

int close(int £d);

Opcje dodatkowe flags:

Do funkcji tej przekazujemy

deskryptor pliku, ktéry chcemy

zamkna¢. W przypadku bledu
funkcja zwraca warto$¢ -1, w
przypadku powodzenia 0. Nie

O_CREAT jesli plik nie istnieje, to zostanie utworzony

O_EXCL jesli plik istnieje i podano dodatkowo opcje O_CREAT, to zwrécony zostaje bad

O_APPEND jezeli otworzymy plik z ta opcja, to kazda operacja zapisu poprzedzona bedzie
ustawieniem wskaznika na korcu pliku, nie ma wiec nicbezpieczenstwa
nadpisania danych

O_SYNC

_ funkcja zapisu (write) powraca dopiero po fizycznym zapisie danych

musimy jednak zamykaé otwar-

O_NONBLOCK |tryb zapisu bez blokowania

tych deskryptoréw plikéw w na-

O_NOCTTY
to nie staje si¢ on terminalem sterujacym

jesli podano w pathname Sciezke odnoszaca si¢ do pliku wskazujacego terminal,

szym programie jesli konczy on
prace, bowiem system au-

O_TRUNCATE

jesli plik istnieje, to jego zawarto$¢ zostaje skrocona do 0

tomatycznie pozamyka

oznaczajaca, ze chcemy utworzy¢ nowy plik, to musi-
my wowczas podac jeszcze uprawnienia do pliku,
ktére zostang mu przypisane w momencie two-
rzenia.

Gdy konczymy prace z danym plikiem, to mozemy

pootwierane przez nas pliki.

Potrzebujemy jeszcze funkeji, ktére umozliwia nam
odczyt i zapis z danego pliku lub urzadzenia. Te
dwie funkcje to read i write.

#include <unistd.h>

ssize_t read(int fd,
size_t count) ;

void *buf,

ssize_t write(int fd, const void

*pbuf, size_t count);

Obie przyjmuja deskryptor pliku odno-

szacy sie do wczeéniej otwartego przez
nas pliku. Nastepnie podajemy adres

bufora, z ktorego czytamy, badz do ktore-

go zapisujemy dane z pliku i na koncu je-

go rozmiar. W przypadku read rozmiar

oznacza maksymalng ilo§¢ danych, ktére

mozemy w buforze zmieSci¢ bez jego

przepeliania, natomiast w przypadku

Uprawnienia mode

5_IRUSR wiasciciel ma prawo odezytu

5_IWUSR wiasciciel ma prawo zapisu

5_IXUSR whasciciel ma prawo wykonania

S_IRWXU whasciciel ma prawo odezytu, zapisu i wykonania, réwnowaine z
S_IRUSR | S_IWUSR | S_IXUSR

5_IRGRP grupa ma prawo odczytu

S_IWGRP grupa ma prawo zapisu

5_IXGRP grupa ma prawo wykonania

S_IRWXG analogicznie do s_IRWXU

S_IROTH pozostali maja prawo odczytu

S_IWOTH pozostali majg prawo zapisu

5_IXOTH pozostali maja prawo wykonania

5_ISVTX bit lepki (sticky bit)

5_ISUID bit ustawienia uzytkownika

5_ISGID bit ustawienia grupy

write oznacza on ilo§¢ danych, ktore
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chcemy zapisa¢. Rozmiar w tym przypadku moze
by¢ wiec mniejszy od rozmiaru bufora.

Funkcja read zwraca ilo$¢ przeczytanych znakéw.
Moze zwracaé¢ warto$¢ 0 — oznacza to, ze dotarta do
konca pliku oznaczonego warto$ciag EOF. W przypad-
ku, gdy zwraca ona warto$¢ -1 oznacza to blad odczy-
tu. Write zwraca iloé¢ zapisanych danych lub -1 w
przypadku bledu. Jeéli wartos¢ zwracana przez write
jest mniejsza od count oznaczaé to moze jaki$ blad
np. fakt, ze skonczylo nam sie miejsce na
urzadzeniu.

Znamy juz podstawowe funkcje obstugi odczytu i za-
pisu do plikoéw. Mozemy wiec napisac¢ nasz pierwszy
program.

#include <unistd.h> /*(1)*/

/*(2) %/

int main(int argc,

{

char *argv[])

char *powitanie = "Witaj Swiecie!!!\n";

/*(3)*/

if( write (STDOUT_FILENO, powitanie, 18)
/*(4)*/

write (STDERR_FILENO,
/*(5)*/

= 18)
"btagd zapi-
su'",

}

11);

Kompilacja tego kodu zrédlowego jak i wiekszosci
prezentowanych w kursie jest banalnie prosta.
Sprowadza sie do wykonania nastepujacego polece-
nia (zakladajac, ze powyzszy kod zZrodlowy zapi-
szemy w pliku o nazwie ,,plik_zZrédlowy.c”:

$ gce plik_zZrodlowy.c -0 nasz_program

Plik binarny uruchamiamy w nastepujacy sposob:

$ ./nasz_program

Zapis ./ oznacza, ze program uruchamiamy z biezace-
go katalogu.

Program ten wypisuje na standardowe wyjsScie
wszystkim dobrze znany komunikat pierwszego
programu.

1)Tutaj znajduje sie wspomniana wcze$niej i wy-
magana przez write instrukcja preprocesora wsta-
wiajaca zawarto$é pliku nagléwkowego unistd.h.
2)Typowa definicja funkcji main.

3)Definicja wskaznika powitanie do c-string z intere-
sujacym nas komunikatem. Tutaj spotykamy sie z
pierwsza rdéznica miedzy ANSI C i ISO C++. Moze
nie widaé tego zbyt wyraznie w tym miejscu, ale w
ANSI C nie dozwolone jest definiowanie zmiennych
w locie (czyli w prawie dowolnym miejscu) jak ma to
miejsce w ISO C++. Zmienne zdefiniowane musza
by¢ na poczatku bloku (czyli po klamrze otwiera-
jacej '{"). Wprowadza to pewne komplikacje i moze
sprawiaé, ze dla osob piszacych na co dzienh w ISO
C++ kod bedzie wydawal sie mniej przejrzysty, bo
definicje zbieraja sie na poczatku bloku kazdej funk-
cji.

4)Wypisanie na standardowe wyjScie STDO-
UT_FILENO zdefiniowane w pliku nagléwkowym
unistd.h komunikatu wskazywanego przez wskaznik
powitanie. Komunikat sklada sie z 18 znakéw i prosi-
my by wypisano wla$nie taka liczbe znakoéow. Jesli
write wypisze mniej znakow lub zwroéci blad, to (5)
wypisujemy na standardowe wyjscie bledow STDER-
R_FILENO odpowiedni komunikat.

Skoro mamy juz za soba ten najprostszy program,

proponuje sprobowaé napisa¢ co$ bardziej skompli-
kowanego i jednocze$nie bardziej przydatnego:
mianowicie program, ktéry jest zamiennikiem
wszystkim dobrze znanego konsolowego programu
cp.

#include
#include
#include
#include
#include

<unistd.h> /* (1) */
<sys/stat.h>
<sys/types.h>
<fcntl.h>
<stdlib.h>

#define SIZE 8192 /*(2)*/

int main(int argc,

{

char *argv[])

int in, out; /*(3)*/
char buff[SIZE]; /*(4)*/
int n; /*(5)*/
if(argc '= 3) { /*(6)*/
write (STDOUT_FILENO, "cp <z>
<do>\n", 13);
exit (1); /*(7)*/
}
if( (in = open(argv[l], O_RDONLY)) == -
1) { /*(8)*/
perror (argv([1l]); /*(9)*/
exit (1) ;
}
if( (out = open(argv[2], O_WRONLY |
O_CREAT | O_TRUNC, S_IRWXU | S_IRGRP | S_IXGRP
| S_IROTH)) == -1) { /*(10)*/
perror (argv[2]);
exit (1) ;
}
while( (n = read(in, buff, SIZE)) > 0)
/*(11)*/
{
if( write(out, buff, n) != n )

perror ("write") ;
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exit (0); /*(12)*/

}

Po skompilowaniu tego programu mozemy przy je-
go pomocy kopiowaé dowolne pliki. Sposéb wywoly-
wania go z linii polecen jest analogiczny do
zwyklego programu cp:

./cp plik.txt kopia_ plik.txt

1)Wlaczamy tym razem o wiele wiecej plikow naglow-
kowych. Oprocz tych, ktore juz znamy, dochodzi jesz-
cze jeden stdlib.h, ktory musimy dodaé, bo
wykorzystujemy dwie nowe funkcje exit i perror.
2)Definiujemy rozmiar bufora, ktéry postuzy nam
do przenoszenia danych miedzy dwoma plikami. Dla-
czego akurat taki rozmiar ma nasz bufor wyja$nimy
sobie dopiero w 3 czeSci kursu. Teraz musi nam wy-
starczy¢ wyjasnienie, ze ta warto$¢ zapewnia najefek-
tywniejsze dzialanie i jednocze$nie nie zajmuje zbyt
duzo pamieci.

3)Definiujemy dwie zmienne calkowite, w ktorych
przechowywaé  bedziemy  deskryptory  pliku
wejsciowego i wyjéciowego naszej operacji kopiowa-
nia.

4)Definicja bufora o rozmiarze SIZE.

5)Zmienna ta postuzy nam do przechowywania ilo-
$ci bajtéow odczytanych przez read i zapisywanych
przez write.

6)Sprawdzamy czy podano po nazwie naszego
programu dwa parametry odpowiadajace nazwom
pliku wejsciowego i wyjéciowego. W przeciwnym ra-
zie wypisujemy odpowiedni komunikat.

7)Tutaj po raz pierwszy wykorzystujemy funkcje
exit. Powoduje ona zamkniecie naszego programu.
Jako parametr przekazujemy jej warto$¢ z jaka

program powraca. Przyjmuje sie, ze warto$¢ rézna
od 0 oznacza, ze program zakonczyl sie na skutek
bledu.

8)Otwieramy pierwszy podany nam przez uzytkow-
nika plik tylko do odczytu, a zwigzany z nim deskryp-
tor pliku zapisujemy w zmiennej in. Jedli proba
otwarcia pliku konczy sie niepowiedzeniem, to przy
pomocy funkcji perror wypisujemy komunikat
ostrzegawczy. Funkcja ta przyjmuje wskaznik do c-
string. Wypisuje ona na standardowe wyjscie
bledéow tekst wskazywany przez ten wskaznik, sta-
wia po tym znak "', a nastepnie sama dodaje od-
powiednia informacje o bledzie, ktéry doprowadzil
do niepoprawnego wykonania sie funkcji. Jesli na
przyklad kazemy skopiowa¢ nieistniejacy plik o na-
zwie plik.txt to program zakonczy sie z bledem:

plik.txt: No such file or directory

9)Wywolanie funkcji perror w przypadku bledu.
10)Otwarcie pliku, do ktérego bedziemy kopiowaé
dane. Plik otwieramy z opcjami O_CREAT i
O_TRUNC tylko do zapisu. Oznacza to, ze jesli plik
nie istnieje, to zostanie utworzony, a jeéli istnieje, to
jego rozmiar zostanie skrocony do 0, czyli jego zawar-
to$¢ zostanie wykasowana. W przypadku bledu po-
dejmujemy odpowiednie dzialania.

11)To jest glowna petla naszego programu od-
powiedzialna za kopiowanie zawartosci plikow z in
do out. Bedzie sie wykonywaé¢ dopoki read powraca
z warto$cia wiekszg niz 0, a wiec odczytuje jakie$
dane i nie dochodzi do konca pliku. Zezwalamy na za-
pisanie maksymalnie SIZE znakéw do bufora buff.
Nastepnie tyle znakow, ile funkeja read odczytala (za-
pamietane jest to w zmiennej n) zapisujemy do pli-
ku out z bufora buff. Gdy dojdziemy do konca pliku

in, funkcja read zwrdci 0 i petla sie zakonczy.

12)Ta linijka zawsze bedzie znajdowa¢ sie na konicu
naszych programéw. Oznacza ona, ze program za-
konczyl sie poprawnie.

Istnieje funkcja, ktérej zadaniem jest wylacznie two-
rzenie nowego pliku. Ma ona pewne wady, o ktorych
powiemy sobie w kolejnej cze$ci. Mozna sie bez niej
oby¢ stosujac funkcje open.

#include <sys/types.h>

#include <sys/stat.h>

#include <fcntl.h>

int creat (const char *pathname, mode_t mode) ;

Funkcja ta tworzy plik o nazwie okre§lonej przez
parametr pathname z uprawnieniami mode. Zwraca
deskryptor pliku odnoszacy sie do nowo utworzone-
go pliku, ktory otwarty jest tylko do zapisu.
Wywolanie:

creat(,,./plik.txt”, uprawnienia);

jest rownowazne wywolaniu:

open(,plik.txt”, O_WRONLY |
O_TRUNC, uprawnienia);

O_CREAT |

Ostatnia z poznanych dzisiaj funkeji stuzy do swo-
bodnego przemieszczania sie po pliku. Przy jej po-
mocy mozemy np. odczytac¢ bajt 27, czy ustawié sie
na konicu pliku. Ta funkcjg jest Iseek.

#include <sys/types.h>
#include <unistd.h>
off_t lseek(int fildes, off_t offset, int when-
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ce) ;

Opcje whence:

SEEK_SET

ustawienie zgodnie z poczatkiem pliku
SEEK_CUR

ustawienie zgodnie z biezaca pozycja wskaznika
SEEK_END

ustawienie zgodnie z koficem pliku

Dla kazdego pliku otwartego w systemie przechowy-
wana jest pozycja wskaznika pliku. Jest to po prostu
numer bajtu, na ktérym zakonczyl sie ostatni proces
zapisu lub odczytu. Normalnie czytajac 10 bajtow z
poczatku pliku, wskaznik ustawia sie na bajcie 10. Po-
dobnie jest w przypadku zapisu. Dzieki temu nie od-
czytujemy tych samych danych ani nie zapisujemy
ich w tym samym miejscu. Dzieki Iseek mozemy jed-
nak swobodnie nawigowa¢ po pliku. Jako pierwszy
parametr przekazujemy deskryptor otwartego
wcze$niej pliku, nastepnie numer bajtu na ktory
chcemy ustawi¢ wskaznik i na samym koncu pozy-
cje, od ktorej bedziemy liczy¢ przesuniecie w baj-
tach. Mozemy liczy¢ od poczatku pliku, od biezacej
pozycji wskaznika lub od konca pliku. Funkcja zwra-
ca biezaca pozycje wskaznika, w przypadku bledu
zwraca -1.

Program demonstrujacy uzycie funkcji Iseek.

#include <unistd.h>

#include <sys/types.h>

#include <sys/stat.h>

#include <stdlib.h>

#include <fcntl.h>

/* (1) */

void error (char * str);

int main(int argc, char *argvl[])
{

int f£d; /*(2)*/

char *zawartosc = "0123456789";
/*(3)*/

char c; /*(4)*/

if( (fd = open("testowy", O_RDWR |
O_TRUNC | O_CREAT, S_IRWXU | S_IRGRP | S_IXGRP
| S_IROTH)) == -1) /*(5)*/

error ("testowty") ;

if( write(fd, zawartosc, 10) != 10)
/*(6)*/

error ("write");

if( lseek(fd, 0, SEEK_SET) == -1)
/*(7)*/

error ("lseek");

read (fd, &c, 1); /*(8)*/

write (STDOUT_FILENO, &c, 1); /*(9)*/

write (STDOUT_FILENO, " ", 1);

if( lseek(fd, 3, SEEK_SET) == -1)
/*(10) */

error ("lseek");

read (fd, &c, 1);

write (STDOUT_FILENO, &c, 1);

write (STDOUT_FILENO, " ", 1);

if( lseek(fd, -1, SEEK_END) == -1)
/*(11)*/

error ("lseek");
read (fd, &c, 1);

write (STDOUT_FILENO, s&c, 1);
write (STDOUT_FILENO, "\n", 1);

exit (0);
}

void error (char * str) /*(12)*/

perror (str) ;
exit (1) ;

Wrynik dzialania programu:
039

1)Program nie jest zbyt ,rozmowny”, ale dzieki nie-
mu mozna dobrze zobrazowaé sposéb przesuwania
wskaznika po pliku. Poniewaz w programie tym
wielokrotnie bedziemy obslugiwa¢ bledy, dodamy
bardzo prosta funkcje, ktora uproéci nam to zada-
nie. Tutaj mamy jej deklaracje a ponizej funkcji
main jej definicje.

2)Definiujemy zmienng, w ktdérej przechowywaé
bedziemy deskryptor pliku, z ktéorym bedziemy
pracowac.

3)Zawarto$¢ naszego przyszlego pliku zapisujemy w
zmiennej zawartosc.

4)Zmienna znakowa, w ktorej
bedziemy dane odczytywane z pliku.
5)Tworzymy plik o nazwie testowy i nadajemy mu
odpowiednie prawa.

6)Zapisujemy w nim odpowiednie dane.
7)Ustawiamy sie na poczatku naszego pliku, ponie-
waz po zapisaniu danych wskazZnik ustawiony jest
na jego koncu.

8)Odczytujemy jeden znak z pliku z jego poczatku.
Nie zaimplementowali$my obstugi bledéw odczytu i
zapisu aby uproéci¢ kod zZrodlowy.

9)Wypisujemy pierwszy znak. Widzimy, ze popraw-
nie ustawiliémy sie na poczatku, bo pierwszym
znakiem w pliku jest znak '0' i taki otrzymali$my.
10)Ustawiamy sie teraz na czwartym znaku (liczymy
bowiem od 0) od poczatku pliku. Odczytujemy go i
wypisujemy. Czwartym znakiem jest 3 i wszystko sie

przechowywac
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zgadza.

11)Ustawiamy sie przed ostatnim znakiem w pliku.
Po odczytaniu go i sprawdzeniu otrzymujemy war-
to$¢ 9. Moze nas to troche dziwi¢, ale po krétkim za-
stanowieniu wszystko wydaje sie jasne. JeSli
ustawiliby$my sie na konicu pliku, to odczytaliby$my
znak EOF. Read powr6ci z warto$cia o i nie przypi-
sze zadnego znaku, a my chcemy odczytaé znak '9', a
wiec ustawiamy sie jeden znak przed koncem by go
odczytad.

Na tym zakoncze pierwsza cze$c. Te podstawowe ope-
racje wejécia wyjécia dostarczanego wraz z Sys-
temem beda przez nas wielokrotnie uzywane.
Jednak stanowia one tylko niewielka cze$é ogromu
funkeji obstugi systemu plikow dostarczanych wraz
z systemem. Bedziemy je sukcesywnie poznawac.

Nie sposéb jest opisa¢ kazda z funkeji doglebnie
wraz ze wszystkimi mozliwymi zwracanymi przez
nia bledami. Po pierwsze z tego powodu, zZe jest to
bardzo obszerny material, po drugie w wielu sys-
temach spotykamy sie z r6znicami implementacyjny-
mi i musielibySmy je uwzglednia¢ co niepotrzebnie
komplikowaloby caly kurs. Elementy przeze mnie "
przedstawiane sa wspdlne dla systeméw zgodnych z d f

POSIX. Sa wiec w peli przenoéne. Nalezy zdawaé e ytor gra ].CZ ny
sobie jednak sprawe z tego, ze wiele systeméw - -
oprocz tej podstawowej funkcjonalnoSci dostarcza plxel.lnf().pl
wiele dodatkowych opcji i mozliwosci, ktére jednak
nie sa przenosne, ale w danym systemie znacznie
usprawniajg pewne operacje. Dlatego nalezy czesto
zaglada¢ do podrecznikow systemowych man (2) w
systemie, w ktorym przyszto nam programowac. m Windows, Linux, MacOS X, Sky Os, BeOs, QNX,

Free BSD, Linspire, MorphOS, eComStation i inne

dragopja,.
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Walka ze spamem

Artykut rzuca troche Swiatta na strone
praktyczng zastosowania filtrow antywi-
rusowych i antyspamowych dla matych
serwerdw pocztowych. Prezentowany
materiat bez problemu dziata zaréwno
na serwerach z zainstalowanym sys-
temem operacyjnym Linux jak i z rodzi-
ny BSD. W jednym artykule nie
jesteSmy oczywiscie w stanie wyczer-
pac¢ calej tematyki - postaramy sie jedy-
nie przedstawi¢ kilka propozycji walki z
ucigzliwodciami dzisiejszej e-poczty.

Celowo pomineli$émy instalacje podstawowych kom-
ponentow (takich jak postfix, sendmail, procmail),
gdyz zazwyczaj znajduja sie w kazdej dystrybucji. Je-
zeli nie, instalacja jest prosta, a o sposobach konfigu-
racji ~mozemy poczytat w  dokumentacji.
Konfiguracja serwera pocztowego jest sprawa odreb-
na i indywidualna.

Definicja spamu

Elektroniczna wiadomo§¢ jest spamem, jezeli:

- tre$¢ i kontekst wiadomosci sg niezalezne od tozsa-
mosci odbiorcy, poniewaz ta sama tre$¢ moze by¢
skierowana do wielu innych potencjalnych odbior-
cow,

- tre$¢ wiadomosci daje odbiorcy podstawe do przy-
puszczen, iz nadawca wskutek jej wyslania moze od-
nie$¢ korzySci nieproporcjonalne w stosunku do
korzy$¢ odbiorcy wynikajacych z jej odebrania

- jej odbiorca nie wyrazil uprzedniej, mozliwej do we-
ryfikacji, zamierzonej, wyraznej i zawsze odwolywal-
nej zgody na otrzymanie tej wiadomosci,

(na podstawie http://nospam-pl.net)

W dziale prawo (http://nospam-pl.net/prawo.php)
mozemy poczyta¢ o regulacjach prawnych majacych
zwigzek ze spamem.

Sprébujemy w artykule opisaé prosty, ale skuteczny
system antywirusowy i antyspamowy.

Zalozenia:

- system operacyjny Linux (dowolna dystrybucja)
lub BSD

- serwer pocztowy sendmail lub postfix

- konta shellowe

- zainstalowany procmail

Pierwsza linia obrony.
Walke ze spamem rozpoczynamy od wersyfikacji
czarnych list. Czarne listy to nic innego, jak serwery

z baza danych o adresach IP ,maszyn”, ktore trud-
nig sie rozsylaniem niechcianej poczty.

Serwery utrzymujace czarne listy:
cbl.abuseat.org
blackholes.mail-abuse.org
relays.mail-abuse.org
dialups.mail-abuse.org
sbl.spamhaus.org
bl.spamcop.net

relays.ordb.org

list.dsbl.org

spam.wytnij.to

Zasada dzialania jest prosta.

Dla uproszczenia thumaczenia zakladamy, iz dowol-
na maszyna wysylajaca poczte jest serwerem.

Serwer pocztowy przyjmuje polaczenie z maszyny X
i sprawdza czy jej adres znajduje sie na czarnej li-
$cie spamerow.

Jezeli odpowied? jest pozytywna (maszyna X jest na
liécie spamer6w), nasz serwer odsyla "caluska" z ad-
notacja ,550 Spam blocked see: ...”

W ten prosty sposob odrzucamy znaczng cze$c
spamu jaka puka do bram serwera pocztowego.
Uwagi:

1. TPSA - tego nie trzeba nikomu tlumaczyé¢, ,idol”
wszystkich internatéw. Mimo iz na wpis whois
tpnet.pl otrzymujemy wskaznik w postaci adresu e-
mail: abuse@tpnet.pl, abuse@telekomunikacja.pl

do walki ze spamem, operator nie robi nic, aby te
sytuacje poprawié. Nic - mam tu na myS$li brak
jakichkolwiek mierzalnych oznak poprawy. Tu wielu
moze spotka¢ niespodzianka, adresy neostrady znaj-
duja sie na czarnej liécie.

2. Inni operatorzy udostepniajacy darmowa poczte
e-mail rowniez tam figuruja.

Problem mozemy rozwiazaé¢ przez odpowiedni wpis
w konfiguracji serwera pocztowego, zezwalajacy na
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odbior poczty z tych serwerow.

3. Wada w/w rozwigzania to dlugi czas oczekiwania
na odpowiedz z serweréw czarnych list.

Wielu dostawcéw poczty e-mail nie pozwala sobie
na zbyt dlugie wyczekiwanie na zgode do wystania
maila i w czasie, gdy nasz serwer weryfikuje czarne li-
sty, zrywa polgczenie i nie dostarcza poczty.

Istnieje rozwiazanie w/w problemu. Mozemy po-
bieraé pliki z listami spameréw w formie tekstowej,
wowczas odpada problem weryfikacji nadawcy on-li-
ne. Nasuwa sie jednak pytanie jak czesto od$wiezaé li-
ste.

Druga linia obrony.

Serwer przyjal polaczenie z serwera X i przeslal
wiadomo$é. Nim trafi ona na konto adresata, musi
przejs$é wiele testow.

W drugiej linii obrony potrzebujemy procmaila i sys-
temu antywirusowego.

Zasade dzialania i spos6b konfiguracji procmaila
znajdziemy na wielu stronach www jak i w samej do-
kumentacji projektu.

Czy to aby przypadkiem nie wirus?

W sieci non-stop krazy duza liczba robakéw, wiru-
sow, koni trojanskich. Tego nie trzeba chyba
nikomu specjalnie tlumaczyé¢. Systemdéw antywiru-
sowych dla system6éw Linux jak i BSD mamy dosé
»~duzy” wachlarz. Nie jest ona tak imponujaca jak dla
Window$, ale mamy w czym wybierac.

Do wyboru mamy projekty komercyjne i open sour-
ce. My wybraliSmy dwa: clamav i mks.

Clamav - jest darmowym systemem antywirusowym.

Procmail + clamav.
W kazdym katalogu uzytkownika serwera mamy

plik .procmailrc.
Edytujemy plik .procmailrc i wprowadzamy nasze
reguly.

Zaczynamy od podstaw. Konfiguracja Sciezek do-
stepu.

PATH=$HOME/bin:/usr/bin:/usr/ucb:/bin:/usr/lo-
cal/bin:.
LOGFILE=SMAILDIR/from

Skanujemy poczte programem antywirusowym clam-

scan

AV_REPORT="clamscan --log=/var/log/clamav/clam-
mail.log --stdout - | cut -d: -f 2°

VIRUS="1if [ "$AV_REPORT" != " OK" ]; then echo

Yes; else echo No;fi"
SCAN="System antywirusowy serwera XYZ:
CLAMAV"

MKSVIR i

:0fw

| formail -a SSCAN"

Do AV_REPORT wprowadzamy status skanowania
programem clamscan.

Dla programu pocztowego (klienta) zostawiamy ad-
notacje, iz poczta zostala poddana sprawdzeniu

przez system antywirusowy clamav i mks.

"X-Scan:

:0fw

* ~X-Virus-Status:
| formail -i "Virus:
RUS: S$SAV_REPORT"
Jezeli clamav znalazl wirusa, wstawiamy Jjego
syganture

Yes

SAV_REPORT" -i "Subject: VI-

:0 B
* ~"X-Virus—-Status: Yes
/SHOME/mail/virus-mail

i kierujemy poczte do skrzynki z wirusami.

A co w przypadku, jezeli nie wykryliémy wirusa?
Mozemy jeszcze zapyta¢ o zdanie system antywiru-
sowy MKSVIR.

MKSVIR swego czasu byl darmowym systemem
antywirusowym, bez wsparcia technicznego i bez od-
powiedzialnoSci za jego uzywanie i przydatnoéé. Nie
wolno bylo go uzywaé do skanowania partycji Win-
dow$owych.

Jaka jest obecnie sytuacja prawna? nalezy przeczy-
ta¢ o tym na stronie firmowej firmy MKSVIR.

Pytamy mks-a co sadzi o w/w poczcie.

:0 £

| /usr/sbin/mks32 -e -s —-f /etc/mks.cfg
2>>/var/log/mks.log | formail —-a "X-MKS-Scan:
“date "

:0 B

* “mks_vir: zalacznik skasowany.*
/$HOME/mail/virus-mail

Jezeli wirus probowat sie przemknaé, to pewnie mks
go ,ustrzelil”. Zawirusowana poczte kierujemy do
skrzynki z wirusami.

Trzecia linia obrony.
Jezeli to nie wirus, to moze spam?

SpamAssassin to program do analizy prawdopodo-
bienistwa przynalezno$ci wiadomosci e-mail do nie-
pozadanych (czyli spamu).

Opis pelnej konfiguracji znajdziemy na stronie
producenta:
http://spamassassin.apache.org/doc.html

Do naszego pliku .procmailrec dodajemy kolejne wpi-
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Sy.

:0 £

| /usr/local/bin/clamassassin 2>>/var/log/cla-
mav/clamav.log | formail -a "X-ClamAV-Scan:
“date "

:0fw: formaill.lock

* ~X-Priority: 5|\
"Priority: Non-Urgent]|\
~“Importance: low

| formail -I "X-Priority" -I "Priority" -I "Im-—
portance"

:0fw: spamassassin.lock

* < 256000

| spamassassin

:0fw: formail2.lock

* ~"X-Spam-Flag: YES
| formail -I "X-Priority: 5"
Urgent" -I "Importance: low"

-I "Priority: Non-

:0fw: formail2.lock
* ~"X-Spam-Flag: YES
/$HOME/mail/spam-mail

Komentarz:

Kazda wiadomo$¢ mniejsza od 256000 bajtow spraw-
dzana jest przez spamassassina.

Konfiguracja spamassasina znajduje sie w podkatalo-
gu kazdego uzytkownika.

W sklad podstawowej konfiguracji wchodzi:

SCORE — poziom, przy ktorym list jest uznawany za
spam (domy$lnie ustawiono na 5.0 pkt)

Na stronie http://spamassas-
sin.apache.org/tests_3_1_x.html (dla wersji 3.1)
znajdziemy pelna game opcji do konfiguracji spamas-
sassin'a.

Przyklady:

score FREE_PORN 4

jezeli wystapi stowo PORN, list dostanie 4 punkty
karne.

score SUBJ_VIAGRA 3

jezeli wystapi stowo VIAGRA, list dostanie 3 punkty
karne.

Mozemy roéwniez analizowac¢ polskie listy i wrzucaé
je do skrzynki ze spamem, gdy napotkamy wpisy
typu:
score
score
score
score

PL_NAJTANSZE
PL_WINDYKACJA
PL_SUBSKRYPCJA

1
1
1
PL_PROMOCJA 1

Punkty karne sumuja sie.

Do spamassasin'a jest takze szereg pluginow
(wtyczek). Do najciekawszych i najczeSciej stosowa-
nych zalicza sie FuzzyOCR.

FuzzyOCR dekoduje grafike do tekstu, a nastepnie
szuka czy tam nie zostal ukryty spam.

Ostatnimi czasy spam z gifami ,podbijal” wiekszo$c¢
serwerdw pocztowych a zwykla analiza tekstu przez
spamassasina dawata mierne rezultaty.

Czwarta linia obrony

Jest to ostatnia analiza poczty przed dostarczeniem
jej do skrzynki adresata.

Spamerzy staraja sie oszukaé wszystkie dostepne fil-
try antyspamowe, falszujac stowa, dodajac znaki za-
miast liter.

Ponizsze reguly analizuja wiadomo$¢ pod katem wy-
stepowania slow uzywanych przez spameréw. Regu-
ly przygotowywane sg na bazie zgromadzonego
dotychczas spamu.

Patrzac na strukture filtru, mozna zauwazy¢ analo-
gie do Spamassassina,.

Komentarz:

1.zaczynamy od granicy minus 250 punktéw
2.nastepnie, je$li mail pochodzi z polskich domen,
odejmujemy kolejne 1500

-250 - 1500 = -1750

3.jesli mail pochodzi z domen w ,poznan”, odej-
mujemy kolejne 3000

-1750- 3000 = -4750

4.w kolejnych wierszach widzimy reguly tzw. kary
5.wyjatek stanowia zwroty grzecznoSciowe w jezyku
polskim, po to by wzmocnié¢ akcent, ze oczekujemy
maili od naszych rodakéw.

Jak widzimy w ponizszych regulach mozna
stosowa¢ zamienniki liter. Innymi slowy: po co
pisa¢ dwie reguly dla:

girl

girls

jak mozna to zrobi¢ w nastepujacy sposob:

gir( 1 | s )

Efektywnosé filtru jest duza.

Przyklad.

Jezeli poczta przejdzie z innej domeny niz *.pl i w
treSci poczty wystapia stowa:

:0 HB:

* =25070

* -150070 "FROM.+@.+\.pl
-300070 "FROM.+@.+\.poznan\.pl
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8070
8070
8070
8070

erotic
porn
PORN
steel

* % F %

poczta zostanie zakwalifikowana do spamu i prze-
kierowana do skrzynki ze spamem.

Reguly tworzone sa przez okolo miesigc i zaleza od
tresci poczty ze spamem.

Dobrze dopracowane reguly daja ponad 90% skutecz-
nos¢.

Oto przyklad postepowania z mailem. Filtr ten dopi-
sany jest jako ostatnia cze$¢ pliku .procmailre.

:0 HB:

* -250"70

* -1500"0 "FROM.+@.+\.pl

* -30007"0 "FROM.+@.+\.poznan\.pl

* 10070 !'“From:

* 20070 !"To:

* 10070 !~Subject:

* 20070 Received.* (advertise|stealth|bulk]|sex)
*

100”2 Received. (coman-
che|apache) .+ (net |com|org) ?

* 5072 "~ (From|To) .* (sex|adult|porn)
* 20070 Message—ID.* (advert|bulk|lov(eling) |aegi-
spam)

* 19070 ~Subject.* (\

sex|adult |porn|gay|erotic|advert)

* 2070 "~Subject.*\$

10070 ~Subject.*\$\$

50070 ~Subject.*\$\$\$

2070 ~Subject.*\!

10070 ~Subject.*\!\!

30070 ~Subject.*\!\!\!

5072 "PP-Warning:

-150"0 witam

-150"0 szkoleni(ale)

-150"0 pozdrawiam

-150"0 pozdrowienia

-150"0 pa(n|ni)

X% o o O X X X X X

PROGRAMOWANIE
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-15070 dat (aly)
10070 $

8070 goodwill
8070 www

8070 steel
8070 gir(lls)
8070 bu(ylght)
80”0 best

80”0 bro

8070 erotic
8070 porn

8070 PORN

8070 girl

8070 tee(n]s)
8070 marketing
8070 lovely
80”0 partner
807”0 man's

8070 pric(eles)
8070 failed
8070 vjiagra
8070 vijagra
8070 xanax
8070
8070
8070
8070
8070
8070
1072
1072

valium
ejuculation
produc (t]s)
playe(r]s)
stronger
custu(m|er)
subject.+remove
remove.+ (subject |request |1list)
1072 reply.*remove
1072 one\ time.* (mail |message)
572 video|pictures|earn
SHOME/mail/spam-mail

DU S T I R S S R S S N N N S N S S T R .

Jezeli wszystkie testy przeszly pomys$lnie, mozemy
spokojnie adresata powiadomi¢ sms-em lub na
komunikator o nowej poczcie dostarczonej na konto.

A co w przypadku, gdy oprogramowanie antywiru-
sowe lub antyspamowe sie pomylilo?
Zalecamy instalacje dodatkowego oprogramowania
do obstugi poczty przez strone www.

My uzywamy openwebmail'a. http://www.openweb-
mail.org

Dzieki dostepowi do poczty przez www mamy wglad
w skrzynki ze spamem i wirusami.

Przedstawili§my tylko wycinek mozliwoéci walki ze
spamem, nie poruszyliSmy tematu weryfikacji
nadawcy czy filtrow bogofilter, graylist, spamd jako
czes$ci zapory sieciowej.

Sposobow konfiguracji filtrow antyspamowych jest
wiele, my zaprezentowaliémy jedna, przetestowang.
Skuteczno$¢ jest bardzo duza i zalezna jest od inten-
sywnoéci dzialania spameréw.

Temat filtrow antyspamowych, jak i sposoby walki z
nimi jest obszernie opisany w internecie na
stronach www i listach dyskusyjnych. ®

http://www.sendmail.org

http://www.postfix.org
http://www.procmail.org/
http://www.ii.com/internet/robots/procmail/qs/
http://spamassassin.apache.org/
http://www.yrex.com/spam/spamconfig.php
http://www.clamav.org/

http://www.mks.com.pl
http://www.openwebmail.org
http://nospam-pl.net
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Eagle — niezbednik elektronika

Jedng z najwiekszych bolgczek w $rodo-
wisku Linuksa — poza sterownikami —
jest brak narzedzi CAD. Jednak okazu-
je sie, ze istniejg producenci udostep-
niajgcy oprogramowanie na platformy
inne niz MS Windows. Mimo ze komer-
cyjne, to dla uzytku prywatnego czesto
jest dostepne bezptatnie. Przyktadem
takiego narzedzia jest Eagle - stworzo-
ne przez CadSoft.

Kazdy elektronik, ktéry musial zrobi¢ plytke dru-
kowana, wie, ze najwiecej czasu pochlania sama czyn-
noé¢ projektowania. Co mlodsi Czytelnicy zapewne
juz nie pamietajg, jak kiedy$ sie rysowalo uklad
Sciezek na papierze milimetrowym badz na kalce
technicznej, a potem na podstawie tego wytrawialo
laminat. Teraz w dobie komputer6w czynnosé ta
przejely specjalizowane programy. W artykule zostat
przedstawiony Czytelnikom opis jak zaprojektowac
uklad zasilacza stabilizowanego w oparciu o scalony
uklad 7805M. Nie skupiono sie na pokazaniu
samych regul projektowania, bo to bylby material
na oddzielny artykut (i to raczej w specjalizowanym
periodyku), lecz na samym poslugiwaniu sie
programem. Zakladam réwniez, ze Czytajacy ma juz

pewna wiedze z elektroniki.

Sam program mozna pobra¢ ze strony
http://www.cadsoft.de/, Czytelnik niech przedtem
sprawdzi, czy nie jest dostepny w jego dystrybucji. Je-
dynymi ograniczeniami programu sa: rozmiar plyt-
ki, maksymalnie 10x8 cm oraz zawezenie do dwoch
warstw S$ciezek, za§ w przypadku edytora sche-
matéw mozemy rysowaé tylko na jednym arkuszu.
Czy to duzo? Niekoniecznie, zwazywszy ze do do-
mowych celow rzadko kiedy projektuje sie wieksze
uklady.

Jesli mamy zainstalowany program, czas na jego uru-
chomienie. Na poczatku pojawi sie ekran podobny
doRys.1:

W gléwnym oknie mamy - w postaci rozwijanej listy
- m.in. biblioteki, skrypty oraz projekty. Zaréwno
biblioteki, jak i projekty przez nas stworzone, do-
brze jest umieszcza¢ w katalogu ,eagle” w katalogu
domowym (podczas pierwszego uruchomienia
program sam zaproponuje te lokalizacje).

Menu: File -> New -> Project wpisujemy nazwe
projektu (w moim przypadku ,Dragonia”). Poczat-
kowo bedzie on pusty. Zacznijmy od stworzenia sche-
matu elektrycznego. Majac zaznaczony nasz projekt,
prawym przyciskiem myszy wybieramy New -> Sche-
matic, co otworzy nam nowe okno - Rys.2

W pierwszej kolejnosci trzeba dodac¢ elementy, me-

[@ Control Panel - EAGLE 4.16 Light Sroy =)
Eile View Options Window Help
Name |, | | Description | Al
C— EAGLE
= Design Rues Design Rules " ) N
=-|ser Language Programs  User Language Programs Lasnyép!)lu:.able.grapmcal
= Scripts Script Files Layout Editor
+ CAM Jobs CAM Processor Jobs

+-Projects Wersion d.16 for Linu

Light Edition
Copyright () 1388-2005

Cadson
&llrights reserved warldwide

Single User License #52131

FOR EDUCATIONAL USE O
Registered to: -
p— ]
4]
Rys.1
'O 1 Schematic - Thome/maciek/eagle/dragonia/untitled.sch - EAGLE 4.16 Lig| &
File Edit Draw View Tools Library Options \yindow Help
lemass[nJw/z=wlaaaaa- [T82
IlE
1o [ =l
L 1N i
& 2%
e P
i
£ W
x o
e
2=
=
3
-
N B o
| 4

Rys.2

nu: Edit -> Add... i pojawi sie nam kolejne okno. Z
uwagi na fakt, iz baza jest spora, warto skorzystaé z
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wyszukiwarki na dole. Poniewaz szukamy stabiliza-
tora liniowego 5V z serii 78xx, zatem najwygodniej
wpisa¢ w pole wyszukiwania fraze ,78*” i nacisngé
ENTER. Pole poszukiwan nam sie zawezi i w galezi
Linear znajdziemy poszukiwany element - Rys.3
Klikamy OK i przenosimy go do naszego projektu.
Po umieszczeniu go na schemacie naciskamy Esc i
szukamy kondensatoréw filtrujacych (po jednym
elektrolitycznym i ceramicznym, zar6wno na
wejScie jak i wyjScie ukladu). Nalezy wyczySci¢ pole
wyszukiwania, wpisa¢ w nie ,CAPA*” oraz nacisnac
ENTER. W galezi Capacitor —> wima znajdziemy in-
teresujace nas elementy. Doboér zostawiam czytel-
nikowi, gdyz musi go dostosowaé¢ do posiadanych
podzespoléw. Ja jako ceramiczne wybralem C2.5/4,
za$ jako elektrolit z serii CPOL-EU: na wejsciu ukla-
du CPOL-EUB45181D, na wyj$ciu CPOL-EUT5Dg.
Po zakonczeniu naciskamy dwukrotnie Esc, powi-
nniSmy uzyska¢ cos, jak na rysunku - Rys.4

Jak widzimy, trzeba obrdci¢ kondensatory C3 oraz
C4, no i jako$§ przypisa¢ im warto$ci znamionowe.
Obrét wykonujemy za pomoca menu Edit->Rotate,
klikajac na elementy. Aby zakoniczy¢, naciénij przy-
cisk STOP na gléwnym panelu w edytorze sche-
matoéw. Podobnie jest z poleceniem przesuwania
(Edit -> Move). Dzieki opcji Edit -> Value/Name
mozemy wpisa¢ wartoSci i nazwy elementow. Jesz-
cze jednej rzeczy nam brakuje. Czego? Wejsc i
wyj$¢. Wracamy zatem do Edit -> Add..., poszukuje-
my Wirepad -> 2.54/1.0 i dodajemy cztery sztuki do
schematu. Mamy juz elementy i wypadalo by je
jako$ polaczy¢. W tym celu wybieramy Draw -> Net.
Trzeba pamietaé, ze taka kolejnos¢, jaka uzyliSmy
przy laczeniu elementbéw, zostanie zachowana w edy-
torze plytki drukowanej! Najlepiej zacza¢ polaczenia

od stabilizatora oraz masy. W ostatecznoéci powi-
nni$my otrzymac co$ takiego - Rys.5

Schemat gotowy. Przejdzmy do zrobienia plytki dru-
kowanej. Z menu File -> Switch to board potwierdza-
my stworzenie plytki na podstawie schematu i
otrzymamy takie okno - Rys.6

Na razie nie wyglada to za ciekawie. Wszystkie
elementy zgrupowane bez zadnego porzadku, brak
zrobionych $ciezek, w dodatku poza wnetrzem ram-
ki, w ktorej powinniSmy umie$ci¢ elementy. Podob-
nie jak w przypadku schematu, przenosimy
wszystko do wnetrza ramki, ale pamietajac o regu-
lach projektowania ukladéw elektronicznych. Na
szczedcie uklad jest prosty. Mozna takze zmniejszyé
rozmiar ramki. Po pewnym czasie mozemy uzyskac
co$ jak ponizej - Rys.7

Co prawda nie jest to jeszcze ostateczna wersja
(wiele polgczen i ulozen elementéw nie zostalo za
szcze$liwie wybranych, artykul ma jedynie pokazac
narzedzie, technike projektowania Czytelnik musi na-
by¢ we wlasnym zakresie), ale mozemy zaja¢ sie two-
rzeniem Sciezek. Mozemy robi¢ to recznie, ale
skorzystajmy z narzedzi robigcych to za nas. Z menu
wybieramy Tools -> Auto... i zobaczymy takie okno -
Rys.8

W General Preferrect Directions mozemy okresli¢
preferowane kierunki trasowania dla warstwy gor-
nej (Top), ktorej nie uzywamy (plytka jednowarstwo-
wa) i Bottom. W pierwszej wybieramy N/A, w
drugiej gwiazdke. Ponadto wybieramy Routing
Grid, czyli szeroko$¢ wyrazong w milsach (jedna
tysieczna cala). Zostawmy domy$lnie 50 mil (1,27
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mm). Wybieramy OK. Program zaproponowal nam
polaczenia - Rys.9

Nie wszystkie sa przez nas akceptowalne i niekiedy
w bezsensowny sposoéb wykonane. Na szczeScie
mozemy dokona¢ retuszu. Z menu Edit wybieramy
Ripup i klikamy na te Sciezki, ktére nam sie nie po-
dobaja. Ja przykladowo usunalem $ciezke laczaca do-
datni biegun kondensatora C3 z pozostalymi
elementami - Rys.10

Korekty dokonujemy za pomoca Edit -> Route. Na
gbrze pojawi sie pasek, gdzie mozemy ustawié¢ spo-
so6b lamania $ciezek i ich szerokoé¢. Po zmianie otrzy-
malem co$ takiego - Rys.11

Teraz chcielibySmy zapewne zobaczy¢ spod plytki,
abySmy mogli zrobi¢ ja domowa metoda wytra-
wiajac w chlorku zelaza. Z menu Edit -> Group za-
znaczamy wszystko i kolejno Edit -> Mirror i
prawym przyciskiem myszy klikamy wewnatrz pola
z elementami. Nastgpi lustrzane odbicie. Teraz nie-
bieska warstwa Bottom stala sie Czerwona Top.
Mamy jednak nadmiarowe opisy. Chcemy zostawié
tylko obrys granic plytki i rozmieszczenie Sciezek z
otworami. Z menu View -> Display/Hide layers
zostawiamy tylko sze$¢ pierwszych warstw (do Di-
mension wlgcznie). Otrzymamy co$ takiego - Rys.12

Teraz mozemy to wydrukowaé¢ (pamietajmy o od-
powiedniej skali) lub wyeksportowa¢ m.in. jako
grafike.

Tworzymy wlasne biblioteki
A co, jesli potrzebnego elementu nie ma w standardo-
wych bibliotekach?

Eagle ma obszerne biblioteki nawet w bezplatnej wer-
sji. Jednak wcze$niej czy pdzniej pojawi sie potrzeba
stworzenia nowego elementu. Okazuje sie, ze jest to
bardzo proste i wymaga jedynie umiejetnos$ci postugi-
wania sie myszkg komputerowa.

Tworzymy przykladowy uklad o oémiu nozkach:

4 wejScia: INO-INg4

2 wyjécia OUTo, OUT1

1 RESET

1CLR

W obudowie SMD (dla wygody — dowolnej)
Otwieramy Eagle. Polecenie: File->New->Library.
Otworzy sie nam nowe okno. Klikamy na skrot -
Rys.13

W dolnym wierszu wpisujemy nazwe biblioteki (u
nas: ,temp”) - Rys.14

Klikamy na ,,Sym” oraz ,OK”, pdzniej na ,Yes”. Za po-
mocg narzedzi - Rys.15

oraz tych na goérnym pasku rysujemy nasz pod-
zespdl (bez noézek). Otrzymamy co$ podobnego jak
na rysunku - Rys.16

Jak wida¢ nie jest to skomplikowane. Teraz dodamy
no6zki. W tym celu klikamy na skroét - Rys.17 i dory-
sowujemy potrzebne osiem pinéw (zalecam zacho-
wacé rozsadek przy rozmieszczeniu koncowek). Teraz
wypadaloby dobra¢ sensowniejsze nazwy, niz te,
ktére proponuje program. W tym celu klikamy na
skrot - Rys.18 i odpowiednio definiujemy piny. Po
tym etapie okno programu powinno wygladac¢ na-
stepujaco - Rys.19

To juz jedna trzecia roboty. Teraz obudowa. Kli-
kamy na symbol - Rys.20

W dolnym wierszu wpisujemy ,temp” - Rys.21

@ 2 Board - lhome/maciekleagle/dragonialuntitied brd - EAGLE 4.16 Light il =l

Eile Edit Draw View Tools Library Options Window Help
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0 3 Board - Bamamaciskiasglaraganisunstied bed - EAGLE 4 16 Light

Ehe Edt Driw s Toch Lbvwy Osters Wedee Help
S CXC =1 0 1

Klikamy na ,Pac” i ,OK” ,Yes”. Tutaj postepujemy
jak przy tworzeniu symbolu. Wszystkie potrzebne na-

Pojawia sie okienko, w ktéorym laczymy symbol z
obudowa, jezeli zastosowaliSmy te same nazwy

le@as®w

[em noiEs 265 [ [

R :

rzedzia sa zlokalizowane w tym samym miejscu. Na
koniec nie zapomnijmy o dodaniu pinéw (smd — dru-
ku powierzchniowego, na dole po lewej stronie) oraz
o wybraniu odpowiedniej warstwy (layer - top). Przy
nazewnictwie zastosujmy te same oznaczenia, jak
dla symbolu (dla wygody).

Klikamy na Edit ->Description i piszemy przyklado-
wo ,temp” - Rys.22

Wybieramy ,,OK”

W koncowym efekcie otrzymamy co$§ podobnego jak
na rysunku - Rys.23

To juz dwie trzecie roboty. Teraz trzeba to wszystko
polaczy¢. W tym celu klikamy na przycisk - Rys.24

W oknie piszemy jak wczesniej ,,temp” i zatwierdza-
my klikajac na ,Dev” oraz OK i Yes - Rys.25

Jesli otrzymamy komunikat bledu o braku upraw-
nien, to warto juz teraz zapisac biblioteke (zalecam
zapis w katalogu ,eagle” w katalogu domowym). W
Edit -> Description piszemy przykladowo ,temp” i
zatwierdzamy. Klikamy na - Rys.26

Wybieramy nasz uklad i przenosimy go do lewego
gbrnego okienka. Potrzebujemy tylko jeden, zatem
po kliknieciu naciskamy dwukrotnie ,Esc” - Rys.27

Wybieramy polecenie ,New” (na dole) - Rys.28
Wybieramy nasz uklad.

Klikamy dwukrotnie na zaznaczone pole (z wykrzyk-
nikiem) - Rys.29

pinéw, to polaczenie bedzie proste - Rys.30

Dobierajac piny z obu okienek i klikajac na polece-
nie ,Connect” otrzymamy - Rys.31

Zatwierdzamy klikajac na ,,OK”. Zaznaczamy opcje
,On” (na dole). W koncowym efekcie otrzymamy -
Rys.32

Jesli wezesniej tego nie zrobiliSmy, to zapisujemy
projekt: File->Save (ponownie zalecam zapis w kata-
logu ,eagle” w katalogu domowym). Teraz wchodzi-
my w ,Control Panel” programu, wyszukujemy
nasza biblioteke i z menu kontekstowego wybieramy
»,uUse” - Rys.33

Na prawo od nazwy pojawi sie duza zielona kropka.
Wtasnie zbudowale$ pierwsza biblioteke — gratula-
cje. Mozesz ja teraz dodawa¢ do swoich projektow.

Jak Czytelnik pewnie zauwazyl, w Eagle — mimo
ograniczen — mozna w bardzo prosty i szybki sposéb
zaprojektowa¢ dowolng plytke drukowana. Warto
wspomnieé, ze podobnie sie pracuje z programem
pod systemami MS Windows i Mac OS X.
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Package
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()8 I Cancel |
Rys.21
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jKatalog

- program do katalogowania ptyt

Kazdy troche bardziej zaawansowany
uzytkownik komputerowy zbiera swoje
dane i jedli ma takg mozliwos¢ archiwi-
zuje je na plytach. Przy pierwszych
Kilku ptytach jeszcze pamieta co znaj-
duje sie na tej z czerwonym napisem, a
co na tej z niebieskg naklejka. Kiedy jed-
nak ptyt jest kilkanascie, zaczyna gubic
sie w poszukiwaniach i stwierdza, ze
reczne przeglgdanie to akurat nie jest
najwygodniejszy sposob znajdowania
potrzebnego pliku.

Przy kilkudziesieciu plytach stwierdza, ze to po
prostu niemozliwe, aby - nie tracac zbednego czasu -
znalez¢ dokladnie ten plik, o jaki mu chodzilo.
Sytuacja jeszcze bardziej komplikuje sie, gdy jeden
plik jest w kilku wersjach na kilku plytach,
roznigcych sie pomiedzy soba data ostatniej mody-
fikacji. Wtedy nadchodzi moment, kiedy uzytkownik
szuka programu, ktéry wspomoze go w tym wysitku.
Programéw, ktére spelniaja taka funkcje, jest

calkiem sporo, w tym wiele bardzo zaawansowa-
nych. Gorzej jest, kiedy uzytkownik chce operowaé
na swoim ,dysko-zbiorze” pod ré6znymi systemami
operacyjnymi - dodawaé i przeszukiwaé baze plyt
pod réznymi OS'ami. Wtedy wybor drastycznie
zmniejsza sie, nie wszystkie takie aplikacje bez-
problemowo znosza prace pod ,udawaczami” in-
nych systeméw (np. Wine).

Taka byla moja droga do pomyslu stworzenia apli-
kacji jKatalog. Te kilkadziesiat plyt, zawierajacych
wiele drobnych plikow, pomieszanych pomiedzy
cdr'ami bez zadnego klucza i porzadku, byto trudne
do opanowania. Aplikacja miala pracowaé
minimum pod Linuksem i Oknami, wiec wybor Javy
byt zupeklie naturalny. Aplikacja pracuje takze pod
innymi systemami operacyjnymi, musza zawierac tyl-
ko odpowiednie $rodowisko uruchomieniowe Java
(JRE, co najmniej w wersji 1.5), do Sciagniecia z
http://java.sun.com/ . Po zainstalowaniu i skonfigu-
rowaniu Javy (JRE) nalezy $ciggnac i zainstalowaé
jKatalog w systemie. Dla Linuksa i Okien przygotowa-
ny zostal bardzo prosty w obstudze instalator, przy-
pominajacy wygladem standardowe instalatory dla
system6w spod znaku MS. Program instalatora
zostal przygotowany w InstallJamer, pozwala na wy-
branie kilku opcji instalacji, sprawdzi czy zainstalo-
wano JRE, poprowadzi prawie ,za raczke”.

M Install jKatalog =10 x|

@ Thiz will inztall jK.atalog on your computer. Continue?

Yes | Mo |

Rys 1 Poczatek instalacji

jkatalog Setup x|

Witamy w InstallJammer - instalatorze dla
jKatalog

Zainstalge on jKatalog w werss 0.4 na Twom komputerze,
Zalecarmy zamknac wszystkie aplikacie przed instalacja,

Klikrs D abe), aby kortynuowac lub Anuj, sby opuscic
nstalator

Dalej | A |

Rys 2 Pierwszy ekran instalatora jKatalog

W innych systemach nalezy rozpakowaé archiwum
uniwersalne i uruchomié¢ poprzez JRE plik jKata-
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log.jar.
Na przykladzie wersji 0.4 (obecnie najnowszej wer-
sji stabilnej) chcialbym zaprezentowaé jKatalog. Po

uruchomieniu program pokazuje okno o programie:
O I=E

Znajdi CD | Przegladaj | Dodaj plyte | O programie

Ratalog wersha 0.4

Strona domowa programu:

http:/ fpreemiabckipl; jatalog,

Austor:
Przem Kalicki

hittps/ ferww preemibalickd.pl

Pierwszym krokiem przy pracy z programem do kata-
logowania powinno by¢ dodanie plyt do bazy
danych programu. Aby to zrobi¢, nalezy wybraé za-
kladke ,Dodaj plyte”. Ekran wyglada wtedy tak:
O

Znajdi CO | Przegladaj | Dodajplyte | O programie

=l01x

Padag nazwe phyty:
Podaj miefsce anajdowania sie phty: EY

i B} sl “iradisodromi

Wide nowa plyte | naciénij "Dodaj CD" Dodaj CO

Rys 3 jKatalog — O programie

To jest powitalna cze$¢ interfejsu programu. Przed-
stawiany jest numer aktualnej wersji, adresy stron
zwigzanych z programem. Kilka sekund po urucho-
mieniu program stara sie skontaktowaé z serwerem,
aby sprawdzi¢ czy znajduje sie tam nowsza wersja
aplikacji. Je$li tak, to $cigga uaktualnienie na kompu-
ter uzytkownika (okolo 300kB). Na tej czeSci format-
ki pokazuje sie dodatkowy napis:

Po kliknieciu w napis program prosi o potwier-
dzenie checi aktualizacji i ponowne uruchomienie
programu. Po restarcie uzytkownik ma najnowsza,
najbardziej aktualng wersje.

Rys 4 Dodawanie nowej ptyty

Uzytkownik powinien wlozy¢ plyte do skatalogowa-
nia, nastepnie wpisaé¢ nazwe plyty pod jaka bedzie za-
pisana oraz zmieni¢ miejsce znajdowania sie plyty w
systemie. Dla systeméw ,okiennych” bedzie to od-
powiednia litera reprezentujaca okreSlony naped,
czyli litera od A do Z, potem dwukropek oraz dwa
»\" (np. ,E:\\” albo ,D:\\” albo ,K:\\”). Dla sys-
tem6w linuksowych nalezy sprawdzi¢ gdzie plyta
jest zamountowana w systemie. JeSli montowana
jest automatycznie, mozna to sprawdzié¢ poleceniem
L~mount”. Wazne jest, aby wpisana Sciezka wskazywa-
la na rzeczywisty katalog, a nie byla linkiem do okre-
Slonego katalogu. Moze to powodowa¢ problemy w
dzialaniu programu. Po podaniu $ciezki i nazwy ply-
ty nalezy nacisna¢ przycisk ,Dodaj CD” i poczekaé

na zakonczenie procesu. Po dodaniu plyty w Linuk-
sie i Oknach wlozona plyta zostanie automatycznie
wysunieta.

Zawarto$¢ plyt jest zapisywana w katalogu do-
mowym uzytkownika, w podkatalogu .jKata-
log/bdfile/. Jest to domyslny katalog roboczy, jedna
plyta to jeden plik w formacie XML. Po skatalogowa-
niu plyty istnieje mozliwo$é obejrzenia zawarto$ci
pliku za pomoca zwyklego edytora tekstowego. Jesli
kto$ chce przenosi¢ swoja baze plyt pomiedzy r6zny-
mi systemami to wystarczy gdy bedzie kopiowatl
wspomniany katalog .jKatalog, z calg zawartoScia
wewnatrz.

Zawarto$¢ skatalogowanych plyt mozna przegladaé
za pomoca drzewa, umieszczonego w kolejnej za-
kladce - ,,Przegladaj”:

Znajdi CO | Przegladaj | Dodaj plyte | O programie

o 3 508
o % o LSt phyte

= 30] Odéwied

o1l

7 CI013

o 3 2006-09-30

o 3 2006-09-24--17.18.14

o 3 Aund-RE-20060928
hieve-it-or-not-this-is-a-BMW-ME- 20060925

Rys 5 Przegladanie zawartosci bazy ptyt

Aby by¢ pewnym, ze widok jest najbardziej aktualny
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nalezy nacisna¢ przycisk ,,0d$wiez”. Drzewo symboli-
zujace plyty, katalogi i pliki jest wtedy budowane
ponownie, na podstawie aktualnych danych. Jako
najbardziej nadrzedne prezentowane sa nazwy plyt,
kazda plyta rozwija sie w zawarte w niej katalogi i pli-
ki. Katalogi dalej mozna klikaé, aby zobaczy¢ ich za-
wartoé¢. Plyty prezentowane sa wedlug porzadku
alfabetycznego ich nazw.

W tym widoku mozna takze usunaé¢ wcze$niej doda-
na plyte: nalezy klikna¢ na nazwe symbolizujaca ply-
te, a nastepnie po naci$nieciu prawym przyciskiem
myszy wybraé¢ z menu kontekstowego ,,Usun plyte”.
Plik, bedacy reprezentacja zawartoSci wybranej ply-
ty, zostanie usuniety, a drzewo katalogowe zostanie
uaktualnione. Nalezy uwaza¢, aby przed proba usu-
niecia zaznaczona byla nazwa plyty, a nie plik albo
katalog.

Przyszla pora na omowienie glownej czesci
programu, czyli wyszukiwania. Aby do niej wej$¢ na-
lezy klikna¢ w zakladke ,Znajdz CD”:
L6 rotaoa

Znajdi CD | Przegadal | Dodaj plyte | O programie

=iz

Wz cendt naewy phiou lub katalogu do wysadkanis: —
ofir Saukail

Fremsdtware dls “pfic;

widemazobe  ==[000)== dyglom| dyplond sdein - [9,460] [10-12-00]

wisdema_phe = =[0001= = dyglon dyplon adesn - [15,068] [10-12-03]

wplemaz phpp = =[020)= = \dyplom),dyplom  [B,7eB] [20-12-03]

wpdima_php = =(020)== \dyplam\cyplom  [14,8k8] (20-12-03]
wilrmazphp ==[010)== ‘preess) hidocs! dyplom’ admin— [9,4kE]  [14-08-05)
wpdrma_php  ==[0000== preen hckocs dyplom' admin - [15968]  [14-08-06]

wiemaz ph = =[0 oo Wrdocy dypbom  [0,7k0] [14-08-06]

widema_phg = =[0 rovns Wdocs! dyplom  [1400]  [14-00-06]

widemaZ phe = =[O0 iy chyplom ackin. [9,88]  [10-12-03]

wpdema_php < <[015)= = ' dyplom’ dyplom’ adein  [15,068] [10-12-03]
wpdemazohe ==[015]== ‘dyplom’.dyplom __[B.7%B]_[20-12-03]1 =
Rys 6 Czes¢ wyszukujaca

Skorzystanie z wyszukiwania jest banalnie proste —
wystarczy wpisaé cze$¢ nazwy poszukiwanego pliku
badz katalogu. Po naci$nieciu klawisza ,Szukaj!”
przeszukiwana jest baza danych plyt dodanych do
tej pory. Wyszukane pliki/katalogi spelniajace zada-
ne kryterium prezentowane sg w wydzielonej czeSci
okna: podana jest pelna nazwa pliku/katalogu, na-
zwa plyty, Sciezka dostepu na plycie, rozmiar oraz
data ostatniej modyfikacji.

Aplikacja posiada dwujezyczny interfejs: jesli sys-
tem posiada polskie ustawienia, wtedy interfejs jest
po polsku. Je§li ustawienia sa inne, wtedy au-
tomatycznie program komunikuje sie z uzytkow-
nikiem po angielsku. Istnieje takze mozliwosé
przettumaczenia komunikatéw na dowolny inny
jezyk.

jKatalog zostal napisany przy uzyciu IDE Netbeans.
Strona domowa tego projektu to
http://przemkalicki.pl/jKatalog/

. czona numerem 5.5.2,
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nymi:

- kernel 2.6.15

= TpXLive 2005

- Emacs-21.4.2

- gVim-7.0.109

- Kile-1.9.1

- IyX-1.4.3

- ImageMagick-6.2. 8.8
- Xfig-3.2.4

- FluzBoz-1. (hc2

- AcrobatReader-7.0.8
- ispell-3.2.06

- Firefor 1.5.0.7

- Dhllp-il.8.5

- aterm-1.00.0

- conky-1.4.2

- iDesk-0.8.0

- tablownch-0. 6

- torsmo-(L18

- pouwtv-5. 95

- zonclock-0L0L 8.1

W ramach portalu TeaM-TL dostepne
jest forum dyskusyine, wiki oraz system

zplaszania bledow flyspray.

Happy TEXing!
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tapiemy byki jezykowe, czyli co
nieco o sprawdzaniu pisowni

Ten artykut bedzie niewyczerpujgcym
tematu opisem jak ustawiC sobie spraw-
dzanie pisowni na kilka popularnych
sposobdéw, a tym samym unikngc
btedow w towarzystwie.

Osoby nieskomputeryzowane czesto nazywaja prze-
sadnie komputer ,taka duza maszyna do pisania”. I
chociaz to nieprawda, to jednak na komputerze
pisze sie bardzo duzo tekstow. A duzo tekstow w spo-
s6b naturalny implikuje duzo bledow (bo myli¢ sie
jest rzecza ludzka). Do poprawiania siebie czlowiek
wymySlit odpowiednie programy. W tym tekscie
chcialbym omo6wi¢ sposoby ustawienia sobie spraw-
dzania pisowni w trzech aktach, bedacych naj-
czestszymi sposobami na produkowanie tekstow za
pomoca komputera. Po pierwsze pliki tekstowe w
konsoli, po drugie przegladarki internetowe i po
trzecie pakiety biurowe. Tak wiec do dziela!

Aspell, czyli jak sprawdzi¢ tekst w terminalu.

Aspell jest uruchamialnym =z linii polecen
programem do sprawdzania poprawnos$ci tekstu w

plikach typu plain-text (czyli czysty tekst) pod
wzgledem ortograficznym. Zastapil on podobny, star-
szy program o nazwie ispell. Zaczniemy od instalacji
aspella. W dystrybucji Gentoo sprowadza sie ona do
polecenia:

emerge -pv aspell aspell-pl

co zainstaluje program aspell oraz jego polskie stow-
niki (w razie potrzeby mozna doinstalowac tez inne
stowniki). W innych dystrybucjach instalacja sprowa-
dza sie do podobnych krokéw (np. instalacja z
rpm'6w). Po instalacji mozna tez doinstalowac stow-
niki pdzniej lub tez dolozy¢ alternatywne slowniki.
Bardzo dobry slownik mozna znaleZ¢é na stronie [1],
po czym nalezy go rozpakowa¢ i zainstalowac
nieSmiertelnym ./configure && make && make in-
stall.

Jak sprawdzi¢ dokument za pomocg aspella? W ter-
minalu wpisujemy:

aspell -c plik.txt
przy zalozeniu, ze plik.txt to wlaénie ten plik ktory

chcemy sprawdzi¢ pod katem obecno$ci bledéow
ortograficznych. Zamiast krotkiego -¢ mozna uzyé

dlugiego polecenia check. Wynik takiego polecenia
powinien da¢ nam ladne okienko zrobione w techno-
logii ncurses z nastepujacym widokiem:

- Powiska - Kenssla =]
Sesp Edycp Wdok Zakbdki  Ustaiwena Fomoc

HESTEEE « szczebrzeszynile chrzaszez bimi W trzeinie

1) Gzegzdlka 2) Gzegzotky

1) Ignaore I) Ignore all

r) Replace R) Replace all

a) Add 1) Add Lower

b) Abort x) Exit

Jak widaé, watpliwe stowo zostalo zaznaczone, za$
pod spodem zostala przedstawiona lista sugerowa-
nych poprawek. Jezeli na ktora$ sie zgadzamy, to na-
lezy ja wybraé¢ za pomoca odpowiedniej cyfry, po
czym program automatycznie przechodzi do nastep-
nego. Jezeli nie — to mozna skorzystac z opcji:

Ignore — Ignoruje bledne stéwko i przecho-
dzi do nastepnego blednego

Replace — Wchodzi do recznego trybu edy-
cji. Jezeli wyraz jest na tyle dziwny, Ze nie ma go w
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stowniku to mozna zasugerowa¢ programowi jak ma
g0 poprawic.

Add - Dodaje stéwko do slownika i nastep-
nym razem nie bedzie ono traktowane jako bledne.
Lista stowek dodanych dla danego uzytkownika znaj-
duje sie w pliku ~/.aspell.pl.pws

Pochodne od powyzszych to: Ignore all,
Replace all i Add lower. Funkcji Abort i Exit chyba
nie trzeba thumaczy¢.

Oproécz takiego prostego polecenia mozemy uzyé
aspella z odpowiednimi opcjami. Cze$¢ opcji wy-
stepuje w formie dtugiej lub kroétkiej (tak jak check).
Najwazniejsze opcje wedlug mnie to:

--lang=jezyk lub -1 Okresla jezyk w
ktérym bedzie sprawdzany tekst; o ile ten jezyk
rozni sie od normalnej lokalizacji systemu; w prze-
ciwnym razie to polecenie jest raczej zbedne.

--encoding=kodowanie Okreéla kodowanie
na jakie aspell nastawia sie sprawdzajac plik. Dla pol-
skiej lokalizacji jest to domy$lnie iso 8859-2 i jezeli
dokument jest zapisany w tym kodowaniu, mozna
nie ustawiac tej opcji. Jezeli natomiast jest zapisany
w innym kodowaniu (np. utf-8), to wypadatoby. No
chyba, ze nie zalezy nam na poprawnym spraw-
dzeniu.

--mode=filtr(tryb) OkreSla tryb spraw-
dzania zalezny od typu dokumentu. Dostepne sg na-
stepujace filtry: html, sgml, tex, email, ccpp, none,
perl, url, comment, nroff, texinfo (nazwy méwia chy-
ba same za siebie; none — deaktywuje filtry, czyli
przywraca tryb domySlny). Na przyklad w trybie
html sg opuszczane wszystkie znaczniki, zas w trybie
ccpp sprawdzane s3 tylko komentarze, za$ opuszcza-
ny caly kod.

--dont-backup Jezeli nie zalezy nam na
kopii zapasowej pliku (np. do pdzniejszego recznego
sprawdzenia), to mozemy uzy¢ tej opcji. Domyslnie
jest to opcja wylaczona i tworzone sa kopie za-
pasowe - z rozszerzeniem .bak (np. plik.txt.bak)-
sprawdzanych plikow.

--master=stownik lub -d slownikOkresla
rozny od domySlnego stownik, ktéry chcemy uzy¢ do
sprawdzania naszego pliku.

Najczestsze ustawienia mozna zapisaé w pliku kon-
figuracyjnym aspella. Dla zwyklego uzytkownika jest
to  ~/.aspell.conf (za§ plik globalny to
/etc/aspell.conf). Na przyklad moj plik .aspell.conf

wyglada nastepujaco:

lang pl
encoding utf-8
master pl
dont-backup

Nalezy zauwazyé, ze opcje linii polecen nakrywaja
opcje z pliku konfiguracyjnego.

Chcesz dowiedziec sie czego$ wiecej o aspell? Wejdz
na strone [2]. Dobry polski opis (sam z niego korzy-
stalem) jest na stronie [3]. Zawsze mozna tez uzy¢
aspell --help.

Sprawdzanie pisowni w necie, czyli jak nauczy¢ prze-
gladarki pilnowania poprawnej pisowni.

Konqueror — To moja ulubiona, chociaz niedoce-
niona przegladarka internetowa (a zarazem
manager plikow, przegladarka grafiki itp.), tak wiec
od niej zaczne. Aby moc sprawdza¢ btedy w Konqu-

erorze nalezy najpierw miec zainstalowanego aspel-
la/ispella (co juz powinieni§my mie¢ za sobg) oraz
skonfigurowaé kilka opcji w Centrum Sterowania
KDE. Wchodzimy zatem do Skladniki KDE =>
Sprawdzanie pisowni i ustawiamy tam trzy wazne
opcje:

Stownik: Domyslny — polski

Kodowanie: Ja osobiScie mam ustawione na UTF-8,
aczkolwiek dla wiekszo$ci uzytkownikow lepiej byto-
by ustawi¢ na odpowiedni dla naszej strefy jezy-
kowej ISO 8859-2 (szczegdlnie, ze chcemy przeciez
skonfigurowa¢ sprawdzanie pisowni w przegladarce
internetowej, a wiekszo$¢ polskich stron interne-
towych jest zapisana wlasnie w kodowaniu iso-8859-
2).

Klient: Aspell

Te same opcje mozna tez ustawi¢ z poziomu prze-
gladarki Konqueror; znajduja sie one w menu Usta-
wienia => Konfiguracja sprawdzania pisowni.
Sprawdzanie pisowni w Konquerorze (np. podczas
pisania tekstow na forach) objawia sie podobnie jak
w pakietach biurowych, tj. zaznaczeniem tekstu na
czerwono. Taki blad mozna poprawi¢ recznie (to
chyba najszybsza metoda, zwlaszcza przy zwyklych
liter6wkach), lub tez wybraé z menu kontekstowego
pod prawym przyciskiem myszki opcje Sprawdz
pisownie. Otworzy sie wtedy okno z mozliwoScia
zmiany blednego wyrazu na jeden z zasugerowanych
lub tez jego manualng edycje.

Opera — I tutaj mechanizm sprawdzania pisowni
jest oparty na aspellu. Po zainstalowaniu owego,
Opera powinna go sama znalezé i skonfigurowaé
sobie. Sprawdzanie pisowni odbywa sie standardo-
wo, tzn. po napisaniu tekstu wybieramy z menu
kontekstowego Sprawd?Z pisownie, po czym otwiera
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sie okienko z sugerowanymi poprawkami. Niestety,
nie ma czego$ takiego, jak automatyczne zaznacza-
nie blednych wyrazéw, co znaczy, Ze sami musimy
pamietaé o sprawdzaniu pisowni (chyba jednak
prosciej jest pamietaé o nierobieniu bledow). Troche
to utrudnia calg istote korekty tekstu, bo gltdbwnym za-
daniem programoéw do sprawdzania pisowni jest wla-
$nie automatyczne zaznaczanie literéwek i innych
niezamierzonych bledéw, niezauwazonych przez czlo-
wieka. A praca z Opera przypomina wertowanie tek-
stu ze slownikiem i samodzielne poprawianie tych
bledow, ktore sie zauwazy.

Firefox — W wersji 2.0 Firefoksa wprowadzono we-
wnetrzny modul sprawdzania pisowni (wcze$niej na-
lezalo korzystaé z wtyczek typu AspellFox [4]).
Nalezy tylko zadba¢, aby zainstalowany byl polski
stlownik. Jezeli takiego nie posiadamy, to kierujemy
sie na strone [5], po czym instalujemy polski stow-
nik (tudziez inne, jezeli nam na nich zalezy) i restar-
tujemy FF. Mamy teraz polski slownik. FF sam
podkresla bledy, ktore mozemy poprawiaé korzysta-
jac z sugestii w menu kontekstowym. Pod prawym

Wiadomodé
haskutkal

jaskotka
jaskolka
jasku tka
Dodaj do stownika

Cofnij

whigj

Zaznacz wszystho

¥ Sprawdi pisownig w tym polu

¥ Polski

Angielski / Stany Zjednoczone

BBCode: wlaczone tag [imgl: whaczone Em Dgdaj stownila...

przyciskiem myszki mamy tez mozliwo§¢é zmiany
stownika, z ktérego FF w danym momencie korzysta
(aby nie dopuszcza¢ do takich glupich sytuacji, ze
Firefox z wlaczonym polskim slownikiem prébuje za-
znaczac angielskie stowka jako bledy).

Zdecydowanie najpopularniejszg ,maszyna” do pisa-
nia duzych ilo$ci tekstu sa pakiety biurowe, a naj-
popularniejszym opensource'owym z nich jest
OpenOffice (w tej chwili wersja 2.0 i to nig
bedziemy sie zajmowac¢). W  dystrybucjach
rpm'owych zazwyczaj polskie stowniki sg instalowa-
ne razem z OpenOffice'm po zaznaczeniu jezyka sys-
temowego jako polski. Jezeli jednak stowniki nie
zostaly zainstalowane lub majac system wielojezycz-
ny chcemy mieé¢ kontrole nad modulami sprawdza-
nia pisowni, to zostaje nam instalacja stownikéw do
OO recznie. Ale po kolei.

1. Sciagamy ze strony [31] co nastepuje: stownik
ortograficzny, stownik dzielenia wyrazéw oraz stow-
nik synoniméw dla OOo 2.x (jezeli zalezy nam na
stlownikach dla innych jezykéw to warto odwiedzié
strone [32]) i zapisujemy gdzie§ tymczasowo
archiwa. Rozpakowujemy wszystko - powinni$my
mieé¢ nastepujgce pliki: pl_PL.aff, hyph_pl_PL.dic,
pl_PL.dic, th_pl_PL_v2.dat oraz th_pl_PL_v2.idx.

2. Przenosimy te pliki to katalogu: /miejsce_g-
dzie_zainstalowaliémy_OO/share/dict/o0oo/ - czyli
w moim wypadku jest to /usr/lib/openoffice/sha-
re/dict/ooo/

3. W owym katalogu powinien znajdowa¢ sie plik tek-
stowy dictionary.lst (jezeli go nie ma to oczywiScie
tworzymy go). Nalezy go wyedytowaé dopisujac na-

stepujace linijki:

DICT pl PL pl_PL
HYPH pl PL hyph_pl_PL
THES pl PL th_pl_PL_v2

gdzie: DICT to ustawienia stlownika ortograficznego
wyrazéw, HYPH odpowiada za modutl dzielenia wy-
razéow, za§ THES za slownik synonimoéow. I tak
mozna dopisaé wiele stownikow wedlug schematu:

DICT jezyk dialekt nazwa_ pliku_ze_ stownikiem

np. DICT pt BR pt_BR (czyli brazylijski dialekt por-
tugalskiego). Podobnie mozna z HYPH i THES.

4. Przydaloby sie jeszcze sprawdzi¢ czy zainstalowa-
ne moduly sprawdzania pisowni sg aktywowane. Mi
wszystko zaskoczyto automatycznie, ale jezeli nie, to
nalezy wej$¢ w Narzedzia => Opcje => Ustawienia
jezykowe => Pisownia => Dostepne moduly jezy-
kow (w wersji angielskiej: Tools => Options => Lan-
guage settings => Writing aids => Available
language modules) i zaznaczy¢ odpowiedni stownik
oraz jezyk polski jezeli trzeba. I wszystko powinno
by¢ gotowe do dzialania.

A jak sytuacja przedstawia sie w KOffice? Po po-
prawnym skonfigurowaniu sprawdzania pisowni w
KDE (patrz punkt z Konquerorem) w KWord powi-
nna pojawi¢ sie w opcjach Konfiguracji podpunkt
Pisownia, gdzie mozna ustawi¢ jezyk domySlny jako
polski plus kilka innych opcji. Natomiast w menu
Narzedzia pojawia sie podmenu Pisownia, gdzie
mozemy zaznaczy¢/odznaczy¢ automatyczne spraw-
dzanie pisowni.
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A moze kto$§ uzywa Abiworda? Tez obsluguje spraw-
dzanie pisowni. Nalezy go tylko wczesniej skompilo-
wac z flaga spell, np. w Gentoo:

USE="spell” emerge abiword

Przy zainstalowanym aspell'a powinniémy mie¢ w
Abiwordzie do dyspozycji automatyczne sprawdza-
nie pisowni (nigdzie nie znalazlem opcji wylaczenia
tego, ale prawde moéwiac, niedlugo szukalem) oraz
opcje Sprawdz pisownie w menu Narzedzia.

Podsumowanie czyli stowo konicowe

Jak widaé¢ wiekszo§¢ moduldéw sprawdzania pisowni
opiera sie na aspellu (dawniej ispellu), ewentualnie
z jego alternatywnymi slownikami. Tylko OpenO-
ffice i Firefox dorobily sie wlasnego systemu spraw-
dzania pisowni.

Jednak nawet mimo wlaczonych réznych slownikéow
i moduldw poprawiania bledéw zawsze zdarzy sie
jaki§ blad w tekscie, ktory sprawdzaliSmy nawet
kilka razy. Pow6d? Po pierwsze — slowniki zawsze sa
ograniczone i nie zawierajg nigdy wszystkich wyra-
z6w poprawnych w jezyku polskim. Po drugie —
jezyk polski jest jezykiem do$¢ mocno elastycznym
zarobwno w skladni zdaniowej jak i slowotworczej,
dlatego nie nalezy wierzy¢ we wszystko, co podkresla-
ja nam odpowiednie programy. Bo w koncu zawsze
ostateczna decyzja nalezy do czlowieka.

Uwaga! Konkurs! W tym tek$cie znajduje sie co naj-
mniej jeden btond. Dla tego, kto znajdzie najwieksza
liczbe bledéw w tym artykule (tzn. wiecej niz jeden),
redaktor zobowigzuje sie wysla¢ piwo w dowolne

miejsce Polski (nie obiecuje, ze dojdzie zimne). Blad
musi by¢ potwierdzony badZ przez nasza korektor-
ke, badz przez kogos z Rady Jezyka Polskiego.

A korzystajac z okazji, chcialbym pozdrowic¢ nasza
korektorke, Ole :-)

Odnosniki do ciekawych stron:

[1] http://www.kurnik.pl/slownik/ort/

[2] http://aspell.net/man-html/index.html
[3]http://forum.slackware.pl/view-
topic.php?t=11951

[4] https://addons.mozilla.org/firefox/1022/
[5]https://addons.mozilla.org/firefox/dic-
tionaries/?lang=pl-PL
[31]http://pl.openoffice.org/addons.in-
dex.html#slowniki
[32]http://wiki.services.openoffice.org/wiki/Dic-
tionaries
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Pisa¢ w konsoli zabawniej nieco,

czyli taki maty asci-art

Artykut  ten  bedzie o  dwdch
programach, ktére potrafig generowac
nieco mniej standardowe postacie tek-
stu w terminalu. A te programy to: cow-
say i figlet.

Cowsay/Cowthink jest programikiem, ktory potrafi
zmusic asci-krowe (a takze inne zwierzaki, ale o tym
po6zniej) do graficznego przedstawienia danego tek-
stu w postaci komiksowego dymku. Mozemy sie w
ten sposob dowiedzie¢ co asci-zwierzaki mys$lg lub
mowig w danym temacie. Wersje cowsay i cowthink
roznig sie tylko rodzajem komiksowego dymku. Ale
czas na pokaz:

< Dragonia Magazine >

IAVA

|[====w |

Tak wla$nie wyglada wynik polecenia w konsoli

cowsay ,Dragonia Magazine”

Oproécz takiego prostego polecenia mozemy uzyé
roznych przelacznikéw, ktére spowoduja, ze nasze
napisy stang sie jeszcze ciekawsze. Na przyklad po-
lecenie

cowsay -f nazwa ,Tekst do napisania”

wypisze dany tekst, ale ze zwierzakiem zdefiniowa-
nym przez zmienng nazwa. Lista dostepnych asci-
zwierzakow znajduje sie w katalogu /usr/share/cow-
say-3.03/cows/ (jak wida¢ jest tak dla wersji cowsay
3.03; dla innych wersji programu $ciezka moze by¢

troche inna). Na przyklad u mnie polecenie
Is /usr/share/cowsay-3.03/cows zwraca nastepu-
jace pliki:

beavis.zen.cow hellokitty.cow small.cow
bong.cow kiss.cow sodomized.cow
bud-frogs.cow kitty.cow  stegosaurus.cow
bunny.cow koala.cow  stimpy.cow
cheese.cow kosh.cow  supermilker.cow
COWET.COW luke-koala.cow surgery.cow

daemon.cow mech-and-cow telebears.cow
default.cow meow.cow  three-eyes.cow
dragon-and-cow.cow milk.cow  turkey.cow

dragon.cow moofasa.cow turtle.cow
elephant.cow moose.cow  tux.cow
elephant-in-snake.cow mutilated.cow udder.cow

eyes.cow ren.cow vader.cow
flaming-sheep.cow satanic.cow vader-
koala.cow

ghostbusters.cow  sheep.cow  www.cow
head-in.cow skeleton.cow

Pod zmienng nazwa w poleceniu pokazanym wyzej
wpisujemy nazwe pliku, ale bez rozszerzenia (.cow).

Jeden z moich ulubionych to:

cowsay -f elephant-in-snake ,,Dragonia Magazine”

< DragoniaMagazine >

Elephant inside ASCII snake

Ci, ktorzy pamietaja ,Malego Ksiecia” od razu
skojarza o co chodzi, a reszta niech lepiej idzie do
czytelni.

numer 9 | 2007

41

dragopja.



PRZY KAWIE ... SYSTEM PROGRAMOWANIE
SOFTWARE

Innym ciekawymi sposobami na urozmaicenie na-
szej ,krowki” jest manipulacja jej oczyma. Stuza do
tego parametry: -b -d -t -y -g -p -s -w. Nie bede opi-
sywal po kolei, co kazdy z nich powoduje, ale
proponuje uruchomié program z danym parame-
trem i zobaczy¢ jak zmienia nam sie asci-krowa. In-
nym parametrem pozwalajacym na wlasnoreczne
zdefiniowanie wygladu oczu jest -e opis_wygladu.
Na przyklad wynik polecenia

cowsay -e ,,QQ” ,Dragonia Magazine”

zwraca, co nastepuje:

< Dragonia Magazine >

)\/\

[1====w |

Oczy nie musza by¢ nawet symetrycznie zrobione.
Nalezy tylko pamietaé o tym, ze mamy do dyspozycji
jedynie dwa miejsca na znaki asci, wiec proba zbyt-
niego skomplikowania wygladu oczu sie nie po-
wiedzie. Niestety, jak zauwazytem, opcje zmieniania
wygladu oczu dzialaja tylko na standardowej krow-
ce, a nie na wszystkich zwierzakach.

Jeszcze jedna opcja zostala mi do opisania. Jest to -
W liczba kolumn, gdzie zmienna liczba_kolumn okre-
§la w ktorej kolumnie ma nastapi¢ zawijanie wierszy
do nowej kolumny. Jezeli liczba_kolumn zostanie
zdefiniowana jako np. 10 to w takim razie 9 pierw-
szych liter zostanie w pierwszym wierszu, natomiast
dziesiagta zostanie przeniesiona do nastepnego wier-
sza. Wynik polecenia

cowsay -W 4 "Dragonia Magazine"

zwraca w konsoli co$ takiego:

/ Dra \
| gon |
| ia |
| Mag |
| azi |
\ ne /

\ /\_/\

\ (00)\

(N )AVAN

1= |

Opisalem chyba wszystkie opcje, z ktorych korzy-
stam, wiec konczymy z moéwigcymi krowami i prze-
chodzimy do nastepnego programu — Figleta. Na
koniec powiem tylko, ze Cowsay jest napisany w Per-
lu, wiec przed instalacja przydatoby sie upewnié czy
mamy Perla w systemie. Sam program mozna Sci-
agnac ze strony [1]. Znajduje sie tez w drzewie porta-
ge w Gentoo lub tez mozna go zainstalowaé z
rpm'6w dla wielu dystrybucji (polecam poszukac
wsrdéd rpm'éw na stronie [2]).

Uwaga taktyczna! Co zrobi¢, gdy chcemy zapisaé
nasz ladny obrazek z napisem do pliku? Nic
prostszego. Po prostu wykonujemy polecenie z prze-
kierowaniem do pliku i gotowe.

cowsay ,Dragonia Magazine” >> plik.txt

Powyzsze polecenie zapisuje nam wynik dzialania
programu cowsay do pliku plik.txt.

Figlet (albo raczej - poprawniej - FIGlet) rowniez
shuzy do generowania ozdobnych napis6w w postaci
znakéw ASCI. W odroéznieniu od Cowsay, to napisy
a nie ich otoczka pretendujg do miana asci-art. Aby
uzyskac napis za pomoca programu Figlet wystarczy
wyda¢ komende

figlet Dragonia Magazine
lub tez

”

figlet ,Dragonia Magazine’

co daje nam:

N ()
L N N
e G G e G e e B G
I /1 N N N N

(—

N/ (O
I A A A I T A N 2N
e O S I 22 e e e /
Il TN N N /T TN

I/

Normalnie figlet traktuje wszystko po komendzie
wlasnej jako tekst do przetworzenia. Jezeli jednak
chcemy uzy¢ opcji w programie, to nalezy pisac tek-
st w cudzyslowie. Z wazniejszych opcji nalezy wy-
mieni¢ uzywanie kerningu, czyli tworzenie
specjalnych odstepéw miedzy literami. Kerning
wlacza sie podajac opcje -k. Na przyklad powyzszy
napis z uzyciem kerningu wyglada nastepujaco:
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figlet -k "Dragonia Magazine"
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Da sie zauwazy¢ réznice, prawda? Z innych opcji
mozemy ustawi¢ wyréwnanie napisu. Mozliwe sa
trzy klasyczne pozycje: wyréwnanie do lewej
(przelacznik -1), wyréwnanie do prawej (przelacznik
-r) oraz wycentrowanie napisu (przelacznik -c).

Figlet umozliwia generowanie napiséw, ktére pozoru-
ja ro6zne czcionki ozdobne. Oprocz domyslnej, moze-
my wybraé czcionke, wedlug ktérej beda tworzone
napisy. Lista dostepnych czcionek znajduje sie w
katalogu /usr/share/figlet/ (sa to pliki z roz-
szerzeniem .flf). Aby uzy¢ wybranej czcionki podaje-
my opcje -f nazwa_czcionki, gdzie zmienna

nazwa_ czcionki, to nazwa pliku z czcionka, ale bez
rozszerzenia.

Np. mozna zrobi¢ napis ,Dragonia Magazine” za po-
mocg czcionki gotyckiej. Polecenie

figlet -f ghotic "Dragonia Magazine"

ijego wynik:

Istnieje takze opcja -d nazwa_katalogu, ktoéra
zmusza program do korzystania z czcionek w po-
danym katalogu. Opcji w programie jest oczywiscie
wiecej, ale nie bede wszystkich tutaj opisywal
(mozna zajrze¢ do mana figleta, aby zobaczyt
wiecej). Strona domowa programu to [3], aczkol-
wiek w sieci jest tez troche stron o tym programie,
gdyz jest on bardzo popularny. Mozna sobie na przy-
klad wygenerowaé figletowy napis w przegladarce
WWW wchodzac na strone [4].

Ramka:

Co to jest ASCI-Art? Jest to sztuka tworzenia ob-
razow, ozdobnych napiséw, komikséw i innych form
grafiki za pomoca liter i innych znakéw w kodowa-
niu standardu ASCI. Istnieje 95 drukowalnych
znakéw ASCI (ze 128 wszystkich znakéw). ASCI-Art
zaczal sie w dawnych, mitycznych czasach, gdy
sieciowa wymiana pogladéw ograniczala sie tylko do
trybu tekstowego. Po wiecej informacji zapraszam
na strony [5], [6], [7].

Przydatne a pozyteczne odnoéniki:

[1] http://www.nog.net/~tony/warez/cowsay.shtml
[2] http://rpm.pbone.net/

[3] http://www.figlet.org/

[4] http://www.schnoggo.com/figlet.html

[5] http://en.wikipedia.org/wiki/ASCII_art

[6] http://pl.wikipedia.org/wiki/ASCII-Art

[7] http://www.ascii.art.pl/

d Faﬁkomnjsne -
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KEXI — Bazy danych dla kazdego

Przyznam sie, ze tytut artykutu zapozy-
czytem z motto projektu, o ktdrym
chciatbym napisaC. Na swojg obrone
moge powiedzieé tylko tyle, ze jest w
tym wiele prawdy. Przede wszystkim
program ten jest darmowy, pewnie na
co dzien widujecie go jako sktadnik
pakietu Koffice w KDE. Ci, ktérzy sie za-
trzymali przy nim na dtuzej, by¢ moze
wiedzg, ze program ten przez wielu uwa-
zany jest za odpowiednik takich
programéw jak MS Access. Nie
wszystkim takie poréwnania pasujg —
po pierwsze dlatego, ze jednak koncep-
cja jest troszke inna (program wydaje
sie 'fatwiejszy' — nie myli¢ z 'prostszy').
Po drugie, Kexi wcigz sie rozwija, na
przyktad obiecujgco wyglada rozwdj
typu danych ‘'object', gdzie poki co
mozna trzymaé zdjecia, ale w przyszio-
8ci bedg to moze i inne popularne pliki.

Na chwile obecna, Kexi jest dostepny takze na takie

platformy jak Solaris, Mac OS X, FreeBSD a nawet
Windows.

Co wtasdciwie Kexi sobg reprezentuje?

Przede wszystkim zawiera podstawowe funkcje wila-
Sciwe aplikacji do tworzenia baz, czyli tworzenie
tabel, zapytan i formularzy. Zapytania mozna przed
wykonaniem przetestowaé¢ pod katem skladni czy
tez wykonywaé. Dzieki mozliwosci stworzenia for-
mularza, mozna w prosty sposéb wprowadzaé dane i
je sortowac. Tabele z danymi da sie od razu dru-
kowaé, wcze$niej ustawiajac wyglad strony, albo
mozna tez je eksportowaé np. do formatu CSV czy
XHTML. Oprocz eksportu czy importu, dziala obstu-
ga schowka, dane daja sie przerzuci¢ np. do Open
Office Writera. Dostepne sa tez narzedzia do
migracji projektéw np z MySQL czy Accessa. Doda-
no obsluge jezykéw skryptowych Python (wla$nie za
jego pomocy zrealizowano m.in. eksport danych do
XHTML) i Ruby. Pewne czynnosci, takie jak two-
rzenie pustej bazy, mozna wykonywaé z poziomu
konsoli. Inne komendy dostepne sa po wydaniu po-
lecenia 'kexi --help'.

Jesli chodzi o silniki baz danych, z ktérymi Kexi do-
gaduje sie, to na razie sg to SQLite, PostgreSQL i My-
SQL. Ten pierwszy to dedykowany i wbudowany
silnik, oparty na plikach. Plusem tego rozwigzania
jest przeno$no$¢ bazy; tak dane jak i struktura bazy
miesci sie w jednym pliku * kexi.

Jak to wyglada?

Po uruchomieniu programu, pojawia sie okno dialo-
gowe z zapytaniem czy chcemy stworzy¢ pusta baze
danych w pliku, czy stworzy¢ nowa baze np. w My-
SQL. W drugiej zakladce okna widnieja opcje otwar-
cia — tak z pliku, jak i polaczenia sie z baza danych
MySQL i modyfikacji jej tabel.

Szczegblnie interesujaca wydaje sie ta ostatnia
opcja. Pozwala ona na przyklad na wygodne za-
rzadzanie baza danych, ktéra wczeéniej tworzyliSmy
z myS$la o wykorzystaniu — przykladowo - w serwisie
WWW. Zarzadzac — czyli zar6wno modyfikowaé, jak

i wydrukowac.
e e ]

Db [t Yew fmet foma Dus Toch Wedos Getee leln
O Kv il il
| Dotrary | Senyt: query |~ i

g

X mE, s -
Rys1 — Tak powinien wyglada¢ wyzej opisany formularz —
widok danych
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Zalézmy, ze chcemy stworzy¢ baze obrazkéw, ktora
bedzie przechowywana w systemie MySQL. Oczywi-
$cie powinni§my mieé¢ w takim przypadku zainstalo-
wany i uruchomiony serwer MySQL. JeSli nie
mamy, nalezy wybra¢ tworzenie bazy w pliku. Za-
znacz wiec na pierwszej zakladce 'create blank data-
base'. Program zapyta nas, czy chodzi o projekt
trzymany w pliku, czy na serwerze baz danych. Wy-
bieramy wiec ta druga opcje i dodajemy wpis o
polaczeniu z serwerem - w ktérym podajemy takie in-
formacje, jak silnik serwera baz danych, port, nazwe
uzytkownika i haslo. Jesli wszystko jest w porzadku
z polaczeniem, to mozna przej$¢ dalej i zaczaé
prace. Okno programu podzielone jest na dwa ob-
szary — nawigacyjny i roboczy. Wystarczy rzut
okiem na pasek narzedziowy i menu, aby przekonaé
sie, ze zostalo to wszystko ulozone w bardzo przejrzy-
sty sposoéb.

W oknie nawigacyjnym znajduja sie 4 grupy obiek-
tow — tabele, zapytania SQL, formularze oraz skryp-
ty. Stworzmy wiec pierwsza tabele — w tym celu
nalezy klikngé prawym przyciskiem myszy na
'tables' i wybraé¢ 'create object: table.... Z prawej
strony ekranu pojawia sie wbéwczas nowy obszar,
gdzie mozna ustala¢ wlasciwos$ci réznych obiektow.
Klikniecie dwukrotne na komorce 'field caption' po-
zwoli nam uzupehié nazwe pola — niech to bedzie
'id' zdjecia. Druga kolumna to typ danych — wybierz-
my 'Integer number' czyli liczba calkowita. W oknie
wlaSciwosSci po prawej stronie mozemy zaznaczy¢
wlasno$ci — np. 'unsigned number' — gdyz nie spo-
dziewamy sie tu warto$ci ujemnych. Dwukrotne klik-
niecie na 'Primary key' sprawi, ze pole 'id' stanie sie
kluczem gléwnym, na podstawie ktorego bedzie
mozna jednoznacznie zidentyfikowaé poszczeg6lne
obrazy w bazie. Kexi sam ustawia dla klucza wlasno-

Rys2 — Obiekt — tabela, widok edycji

§¢ automatycznego numerowania dodawanych obiek-
tow.

Kolejnym polem niech bedzie 'tytul', typu 'text' o dlu-
gosci np. 25 znakéw (opcja w panelu wlasciwoscei po
prawej stronie). W analogiczny sposéb dodajmy po-
la 'data_dodania' (tu warto wybraé typ 'date/time’,
po czym w oknie wlasciwoSci wybraé podtyp 'date
and time'") oraz 'obraz'. To ostatnie pole bedzie prze-
chowywaé¢ — jak nazwa wskazuje — plik obrazka.
Ustalamy mu wiec typ 'Object' i we wlaSciwoS$ciach
podtyp 'Tmage' (ktéry zreszta powinien byé wybrany
domyslnie).

Warto w tym miejscu wspomnie¢ o tym, ze wykonali-
$my te operacje w trybie 'edycji'. Na pasku narzedzi
znajduje sie grupa trzech przyciskow, z ktoérych
kazdy reprezentuje inny widok: widok danych (czyli
mozliwo$§¢ dodawania rekordow — w przypadku
ogladania tabel), widok edycji i widok tekstowy
(przydatny podczas edycji zapytan do bazy).
Sprobujmy dodac jakie$ obrazki do naszej bazy. Za-

pisz tabele a nastepnie przejdz do widoku danych i
wpisz potrzebne informacje — tytul i date dodania.
Obraz dodamy za chwile. Po dodaniu wpisu,
program generuje kolejny pusty rekord gdzie mozna
umieszczaé nowe dane.

Jesli mamy juz kilka obrazkow, to mozemy stworzyé
tez wygodny formularz, ktory postuzy do przeglada-
nia czy dodawania rekordow w prostszy sposob.
Kliknij prawym przyciskiem na 'Forms' w pasku na-
wigacyjnym i wybierz 'create object: form'. Pojawi
sie edytor interfejsu w stylu WYSIWYG, w ktéorym
dostepne sg takie obiekty, jak okno przegladania ob-
razkow czy pola tekstowe.

Formularz nalezy polaczy¢ ze zrédlem danych -
znajdz opcje ,,Form's data source...” w oknie wlasci-
woSci po prawej stronie i wybierz nazwe tabeli z ob-
razkami. Okno wladciwoéci w trybie edycji
formularza ma trzy zaktadki, jedna dotyczy wygladu
i zachowania sie obiektu, druga jego powiazania z
danymi, trzecia za$ przedstawia drzewo obiektow
formularza.

Kliknij na ikonke przedstawiajaca obraz (‘image
box"), znajdujaca sie na pasku narzedzi, i wstaw ten
obiekt do formularza — klikajac na jego obszar.
Teraz polacz go ze zrédlem danych podobnie jak
sam formularz — kliknij na obiekt i ustaw opcje
~Widget's data source” na 'obraz'. Ponizej zobaczysz
tabelke, gdzie wymienione sg istniejace w twojej ba-
zie kolumny. Mozesz je umiesSci¢ na formularzu me-
toda przeciagnij-upué¢. Beda one automatycznie
powiazane z odpowiednimi polami w bazie. We wla-
Sciwoéciach obiektu 'image box' warto ustawic

opcje: 'scaled contents' i 'keep ratio' — obrazek
bedzie skalowal sie do rozmiaru okienka i zachowa-
ne bedg proporcje.

Teraz mozemy juz przejSé do widoku danych for-
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mularza. JeSli wszystko jest w porzadku, powi-
nniS§my moc przeglada¢ nasze zdjecia, zmienia¢ im
dane, podmieniaé¢ sam obraz i dodawaé nowe wpisy.
Jedli masz jakie§ problemy z dodawaniem wiek-
szych plikow do bazy danych (ja zaobserwowalem
ten problem przy konfiguracji: Kexi 1.1.1, MySQL
5.0.33), mozesz sprobowaé przechowywaé swoje
dane w formie pliku *.kexi. Przy pracy z nimi warto
pamietac o tym, ze istnieje mozliwo$¢ ich optymaliza-
cji, skutkiem czego wynikowy plik nieco sie zmniej-
szy. Aby tego dokona¢, wywolaj polecenie 'Compact
database' z menu 'Tools'.

Dodanie w okienku nawigacyjnym obiektu typu 'qu-
ery' (zapytanie) pozwoli wySwietla¢ tylko te dane w
widoku danych, ktore odpowiadajg dzialaniu instruk-
¢ji SQL. W widoku tekstowym obiektu 'query’,
mozesz wpisaé takie zapytanie: ,SELECT id, tytul,
data_dodania FROM obrazy WHERE obrazy.id =
3”. Teraz widok danych obiektu 'zapytanie' bedzie po-
kazywal wylacznie informacje o obrazku nr. 3.

Mugherticatan
Username: |roct
e Bt sassssesses

X Save password jn the shortout file

Crmste Project | Open Existing Project
= Peajects stored in a fle
W/ & Prmjects giored on a database server

======

Selact Faisting Databass Servers Connection From the List Below
Herm you may{ L

remove cosnectons from the st
[Wama = Typm Sareer Infammatn e

o g v GE | % gancel

Rys3 — kaczenie sie z lokalnie zainstalowanym serwerem
MySQL

Przydatne linki:

http://www.kexi.pl/Kexi_w_akcji - strona =z
kilkoma przykladowymi filmami instruktazowymi
http://koffice.org.pl/kexi/ - polska strona projektu
Kexi
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KPovModeler — zabawy swiattem
— jak zrobi¢ prosty krajobraz

W artykule z poprzedniego numeru opi-
satem podstawowe funkcje programu
Modelera, a takze proces instalacji
modutu do raytracingu — koniecznego
do pracy - oraz opis wykonania przykfa-
dowej sceny. Opisane tam sg tez podsta-
wy taczenia obiektéw i troche o
Swietle. Jesli nie masz doswiadczenia
przy pracy z Modelerem, polecam za-
poznanie sie najpierw z tamtym artyku-
tem.

W tym teksécie chcialbym pokaza¢ kilka innych
ciekawych mozliwosci, ktore wypelniaja niedosyt,
jaki by¢ moze poczuli miloénicy wszelakich krajobra-
zOw, takze cyfrowych. Ot6z do projektow
KpovModelera mozna przenosi¢ rowniez takie obiek-
ty jak narysowane ksztalty, rysunki, a takze stwo-
rzyé pelnoprawny krajobraz z goérami, woda i
niebosklonem.

I wlaénie to ostatnie bedzie naszym celem w tym po-

radniku. Wykorzystamy tu, oprécz znanych juz pod-
stawowych figur, kilka nowych obiektow.

Height field (grupa 'finite solid primitives') — pozwa-
la na przeniesienie obrazka w skali szaros$ci do
KpovModelera. Ciemne obszary rysunku beda poto-
zone nizej, za$ ja$niejsze wyzej. Dzieki temu obiek-
towi mozliwe jest umieszczenie na scenie jakiego$
zawilego znaku czy pisma odrecznego. Nam postuzy
to do stworzenia gor.

Przygotujmy wiec odpowiedni rysunek, najlepiej za

pomoca Gimpa, poniewaz posiada on odpowiedni
do tego celu skrypt Script-Fu. Otwoérz Gimpa, i nie
tworzac nowego rysunku wybierz z menu 'Dodatki'":
'Script-Fu' -> 'Desenie' -> 'Plaski lad...". Wszystkie
opcje oprocz rozdzielczo$ci mozna zostawi¢ bez
zmian, za$ samg rozdzielczo$é ustawié¢ np. na 350 x
350. Rozdzielczoé¢ wplynie na wyglad naszych gor.
Teraz wystarczy zapisa¢ ten rysunek jako PNG
(splaszczajac warstwy) w katalogu, do ktérego ma
dostep modul Povray (jeSli nie wiesz jak to zrobié,
zapoznaj sie z artykulem z poprzedniego numeru,
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gdzie jest to wyjaénione).

Teraz mozesz juz umiesci¢ gory w nowym projekcie
w Modelerze - wstaw obiekt height-field, a w jego
wlasciwos$ciach podaj Sciezke dostepu do uprzednio
stworzonego rysunku z Gimpa. Warto zaznaczyé
opcje 'Smooth’, co sprawi, ze gory beda wygladac¢ na
gladsze i naturalniejsze. Wspolrzedne i rozmiar he-
ight-fielda ustaw w nastepujacy sposob:

X Y z
Translate =12
(wspdlrzedne)
Scale (rozmiary) _Sﬂl 25 50

=
=

Oczywiécie gory w obecnym ksztalcie beda czarne,
wiec musimy nadaé¢ im kolor — w obiekt 'height
field' wstaw obiekt 'pigment', a w niego z kolei 'solid
color' — np. Szary.

Warto juz teraz ustawi¢ w odpowiednim punkcie
kamere i $wiatlo. Ponizej podaje wspdlrzedne,
jakich uzywalem piszac ten poradnik.

Kamera:

Location ) 27 =13

Look at 9 16 3l

Reszte opcji mozna zostawi¢ bez zmian.
Swiatlo:

| X [Y [z |
|Loc:ﬂt ion

-
[
o
=

1 »
[E 1= RO e i B0 L0GBVYFHdIFPNOI A DO THDrAA
200 PFE VRO @RGP DR LOFL]

EUADEEH BB GLESCONSHENSEODEEEEDEHO » ¢

=R (Rl wamseplevel (10 2] Glabal detal: | ery High |+

Rys. 3 — Po lewej stronie znajduje sie drzewo obiektéw,
wykorzystanych w tym poradniku

Kolorem $wiatla moze by¢ np. pomarancz - bedzie
on ladnie kontrastowa¢ z niebieskim niebem, ktore
za chwile stworzymy. Do ostatecznego renderingu
warto jest zaznaczy¢ opcje 'area light' we wlasciwo-
éciach $wiatla. Zrodlem $wiatla jest wowcezas plasz-
czyzna, a nie punkt. OSwietlenie wyglada wtedy
nieco naturalniej, szczegblnie cienie. Minusem jest
znacznie wydluzony czas renderingu.

Teraz mozemy zrobié¢ kilka oczek wodnych, stworz
wiec na scenie prostopadlo$cian, i ustaw jego wilasci-
woSci w nastepujacy sposob:

Y Z
Sgale (rozmiar) |50 15 50
Translale 12 2 7

Gory beda cze$ciowo zanurzone w tym szeScianie,
wiec powinno wygladaé to jak seria oczek wodnych
wérod gor.

Dodaj do prostopadlo$cianu element 'Pigment’ i

'solid color'. Temu ostatniemu nadaj barwe blekitna
(RGB: 0.7, 0.8, 1) oraz ustaw obie wlasnoéci 'Filter' i
"Transmit' na 0.2 (to sprawi, ze woda bedzie lekko
przezroczysta). Dodaj tez opcje 'finish' czyli wy-
konczenie. Z kolei w jego wlasciwoéciach ustaw 'Me-
tallic' na 0.3 (polysk) i wlacz odbicia (opcja
'Reflection’), a za barwy maximum i minimum przyj-
mijmy jakie$ odcienie niebieskiego.

Teraz pora na wykonanie nieba. Z menu 'Insert' wy-
bierz 'Atmospheric effects' -> 'Skysphere'. Niebo
musimy pokolorowa¢, wstaw wiec wen obiekt 'pig-
ment'. Do niego z kolei wstaw obiekty 'Pattern' (po-
winien by¢ na pasku narzedziowym z lewej strony)
oraz 'Color map'. Ten ostatni to zbidr obiektow
'Solid color', wiec wstaw do niego 4 kolory, i nadaj
im lekko réznigce sie odcienie blekitu. W obiekcie
'pattern’ mozesz wybraé tryb 'agate' — od tych usta-
wien zalezy, jak uloza sie kolory ze zbioru 'Color
map'.

Jesli wszystko poszlo zgodnie z planem, krajobraz
powinien by¢ gotowy. Do ostatecznego renderingu
warto wlaczy¢ antialiasing i zwiekszy¢ rozdzielczosé
w opcjach 'View' -> 'Rendering modes' i edytujac
odpowiednio domy$lny tryb, badz stwarzajac nowy.

) O @ W«
| [poul L ¢

Rys. 4 — W razie problemoéw - ikonka obiektu
'height field'
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GImp - robienie fajerwerkOw i criars)

1. Zacznijmy od nowej pracy - tutaj rozmiar nie ma
znaczenia, jednak troche miejsca sie przyda (np.:
800x600). Nowa prace wypelniamy kolorem
czarnym (GFlara na ciemnych barwach jest najlepiej
widoczna)

2. Uruchamiamy: "Filtry->Efekty $wietlne->GFla-

ra...
Powinny$my zobaczy¢ takie oto okienko:

Ustawlenla Wybor

Bright_Star

Classic

Distant_sun
GFlare 101

GFlare 102
Hidden_Planet

Nowy Modyfikuj Skepiuj Usuf

Anuly) l oK

Pomog

Zakladka "Ustawienia" sluza do ustalenia jak ma
by¢ potozony dany obiekt - dana flara, zabawa suwa-

kami szybko wykaze do czego one stuza, o ile mamy
aktywna opcje: "Automatycznie od$wiezaj podglad".

My zajmiemy sie jednak zakladka "Wybor".

3. Klikamy na przycisk "Nowy". Podajemy nazwe:
"Fajerwerki" czy jak tam kto woli "Fireworks".

4. Wybieramy nowo utworzony obiekt i klikamy na
przycisk "Modyfikuj"

[0 [pramrin | Boarmiarie | Qodtkoms prrsbiyk

‘‘‘‘‘

iy

Pomes Cntbwiet prasienty E) | *

Tu chwila refleks;ji.

Obiekty generowane przez GFlare, skladaja sie z 3
elementow:

Jarzenia - czyli to czerwone

Promieni - czyli to biale cienkie wychodzace ze $rod-
ka dodatkowe przeblyski - te biale kuleczki ulozone
w jednej linii.

Przyjrzyj sie okienku: oprécz zakladki "Ogoblne", sa
tu jeszcze 3 inne, noszace nazwy jak wymienione
przeze mnie punkty. Jak slusznie mozna sie domy-

§li¢, kazda z nich odpowiada za edycje jednego z
tych elementow.

Zawarto$¢ tych zakladek zasadniczo jest taka sama.
Roznice sa nieznaczne i wynikaja z réznic pomiedzy
elementami.

Wrbéémy jeszcze do zaktadki "Ogolne". Jak widzimy,
kazdemu z elementéw skladowych jest przyporzad-
kowany suwak "Krycie" oraz listbox "Tryb rysowa-
nia", dzieki temu mozemy pewne elementy flary
lekko zamaskowa¢ innymi (zmieniajac standardowe
ustawiania) czy nawet je ukry¢ - wpisujac jako war-
to$¢ krycia zero - tak tez zrobimy: "Krycie" dla
"Jarzenia" i "Dodatkowych przeblyskéw" ustawiamy
na zero.

5. Klikamy na zakladke "Promienie"

Przyjrzyjmy sie grupie "Gradienty", gdyz to ona shu-
zy do wyboru ksztaltu i koloru flary.

Gradient promienia - jak nazwa wskazuje, to taki
gradient, jaki zostanie przeciagniety od poczatku
promienia, do jego konca - odpowiada za kolor - tu
nalezy pamietaé, ze cze$¢ gradientu moze byc
przezroczysta ( promien w tym miejscu bedzie mial
"przerwe").

Gradient katowy - na podstawie przypisanego
gradientu wylicza on w jakim kierunku maja biec
promienie. Troche to zagmatwane byé¢ moze, ale do-
powiem, ze jak ustawimy "%white", czyli po prostu
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jednolity kolor bialy, promienie beda biec we
wszystkich kierunkach, jesli ustawimy np.: "%white-
_grad", promienie beda coraz bardziej blednaé.
Gradient rozmiaru katowego - to z kolei odwzorowu-
je odcien koloru w dlugo$¢ promienia w w danym
kierunku. Kiedy ustawimy "%white" wszystkie
promienie beda réwnej dlugosci.

My ustawiamy:

"Gradient promienia" na "Blinds"

"Gradient katowy" na "%white"

"Gradient rozmiaru katowego" na "%random"

Parametry - do czego stuza - latwo sie domyélec, cho-
ciazby po nazwach.

Do naszych fajerwerk6w ustawiamy:

Rozmiar: 200

Obroét: o

Obrét odcienia: o

Liczba szpilek: np.: 70

Grubo$c¢ szpilki: 8o

[T SRR yee—

Klikamy ok.

6. Gotowe. Teraz mozemy umieszczac fajerki gdzie
chcemy i o wybranych parametrach:

SOFTWARE

Ustawienia |Wybér
Srodek

% 395

¥ |262 S =
Parametry

Promien:

Oprot:
Obrot odclenia: 0.0

Kat wektora: 60,0

Dlugosé wektora: 4000 =

Nadprobkowanie adaptywne

X Aytomatycznie odéwiet podglad

Pomog Anuluj oK

7. Jak pokolorowac taki efekt?
Np.: przez utworzenie nowej warstwy nad fajerwer-
kiem, wypelnienie jej jakim$§ kolorem, a nastepnie
zmiane jej trybu krycia na "Pokrywanie".
Warstwy 3 ® :
— S m 8. Przy p’unkmef 5—tym,
warto sprobowaé jeszcze
g |innych gradientéw (na po-
zycji "Gradient
promienia"): "Four
Bars", "Three Bars Sin,
"Shadows1", "Flare Glow
Radial 4". Inne oczywiscie tez moga przynies$c
calkiem ciekawy efekt.

Erycie:

>
@ mFaiemerk
- W

9. Zeby uzyska¢ "krzyze", "Xy" itp, nalezy ustawié
"Gradient katowy" i "Gradient rozmiaru katowego"
(na zakladach "Jarzenie" i "Promienie") na np.:
"Four Bars", w razie potrzeby zmodyfikowaé
wspolezynnik obrotu.

10. Zeb
uzyskaé
efekt "spi-
rali"czy
"muszli"
na tychjis
samych
zakla-

dach ustawiamy gradient ktory przechodzi od kolo-
ru jasnego w ciemny - np.: "%blue_grad".

11. Zachecam do pobawienia sie tym narzedziem.
Mozna z niego uzyskac ciekawe efekty.

Pytania na temat tutoriala mozna kierowa¢ na ad-
res: ziomioslaw@wp.pl.

Na podstawie opisu autorstwa Aurore (zamieszczo-
nego na stronie: http://home.tele2.fr/auroreblen-
der/gimp/artifice_en.html)
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Chrom — Satyna w Gimpie

Przedstawiam prosty spos6b na uzyskanie
ciekawego napisu w stylu satynowanego chromu.
Tutorial przeznaczony jest dla os6b poczatkujgcych
lub $rednio zaawansowanych, znajacych podstawy
obstugi Gimpa lub innych programéw graficznych.

Oto efekt jaki uzyskamy po przerobieniu tego
tutorialu:

W ESEST=

SSEE,

I o)
] =]

==

1. Rozpoczynamy od utworzenia nowego obrazka
np. 450x150px z bialym tlem.

2. Za pomoca czcionki pikselowej tworzymy czarny
napis na naszym obrazku. Ja wykorzystalem popular-
na czcionke stosowang w userbarach Visitor TT2 -
BRK.

OS5

3. W palecie warstw klikamy PPM* na warstwie tek-
stowej i z pojawiajacego sie menu wybieramy "Do-
pasuj wymiary warstwy do obrazu".

PPM?* - prawy przycisk myszy

4. Dla tej warstwy tekstowej rowniez w palecie
warstw zaznaczamy "Zachowanie przezroczystosci”.

W arztiag [l

Tryk: | Dwevkdy @_-
Krycie: (3 1000,
@ e

5. Resetujemy kolory w narzedzidwce, skrotem D,
do czarnego i bialego lub klikajac w miejscu widocz-
nym na screenie.

-

6. Wybieramy narzedzie do tworzenia gradientéw L.

7. Przeciggamy po naszym napisie gradientem w
pionie od dotu do gory, tak aby zaczynal sie ponizej
napisu i konczyl powyzej niego. Typ gradientu do-
myS$lnie "Kolor pierwszoplanowy na kolor tta (RGB)"

e e

8. Duplikujemy warstwe tekstowa i nazywamy ja
"poéwiata".

9. Wypeliamy ja bialym kolorem poprzez prze-
ciggniecie bialego koloru z narzedziéwki na obrazek
lub miniaturke tej warstwy lub uzywajac skrotu Ctrl
+.
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10. Odznaczamy "Zachowanie przezroczystosci" dla
warstwy "poswiata".

11. Rozmywamy ja: "Filtry > Rozmycie > Rozmycie
Gaussa" o promieniu 15.

12. Dodajemy teraz maske dla warstwy "pos$wiata"
poprzez klikniecie PPM na niej i wybraniu "Dodaj
maske warstwy...".

W wyskakujacym okienku pozostawiamy
znaczenie "Biala bez przezroczystosci".

za-

13. Klikamy teraz PPM na warstwie z napisem i z
pojawiajacego sie menu wybieramy "Kanat alfa na za-
znaczenie".

14. Zmniejszamy zaznaczenie poprzez "Zaznaczenie
> Zmniejsz" o 1px.

15. Zmiekczamy zaznaczenie poprzez "Zaznaczenie
> Zaokragl" ustawiajgc 5px.

—————————————————————————————————————————————————————————

___________________

16. Powracamy do warstwy "poswiata" klikajac na
miniaturke maski, a nie miniaturke warstwy.
Dookola miniaturki maski powinna sie pojawié
biala ramka, co oznacza, ze teraz pracujemy wiladnie
na masce a nie na warstwie.

17. Przeciggamy z narzedzidwki kolor czarny na ob-
razek oraz pozbywamy sie zaznaczenia za pomoca
Ctrl + Shift + A

18. Majac ciagle aktywna maske warstwy, wybiera-
my narzedzie "Przesuwanie warstw i zaznaczen" M.
Przyciskamy raz strzalke na klawiaturze w dot i raz
w prawo. W ten sposob przesuneliémy nieco maske
dla lepszego efektu.

e ]

W arshwyp = =@ . .

Tt | Zuvs - @ |19- Duplikujemy  war-
Krycie: () G0o » |Stwe z napisem 1 przesu-
. —-NI:|EE wamy J3 na samg gore

oraz zmieniamy jej na-
zwe na "obrys".

20. Wypeliamy teraz
nowa warstwe "obrys" przeciagajac na nia bialy
kolor z narzedzi6wki.

21. W palecie warstw klikamy na warstwie "obrys"
PPM i wybieramy z menu "Kanal alfa na za-
znaczenie".

22. Zmniejszamy zaznaczenie poprzez "Zaznaczenie
> Zmniejsz" o 1px.

23. Teraz usuwamy zawarto§¢ poprzez "Edycja >
Wyczyé¢" lub Ctrl + K, pozbywamy sie rowniez za-
znaczenia "Zaznaczenie > Brak" lub Shift + Ctrl + A

24. Zaznaczamy warstwe z naszym napisem wype-
nionym gradientem i przechodzimy do okna edycyj-
nego.

25. Dodamy teraz cien "Script-Fu > Cienn > Rzucanie
cienia"
- Przesuniecie X - 3
- Przesuniecie Y - 3
- Promien rozmycia - 6
- Krycie - 50
- Dopuszczalne powiekszenie - odznaczamy
x

Auguarraniy skiyply

26. Duplikujemy war- feosex (3
stwe z napisem i przesu- "

Promiedi zmyciad &

wamy nad warstwe z —
cieniem. iy ° QF
‘}Wsz\:uhe powikszanie

Poatip prastwazana Sy
[Ersk)

27. Wypelniamy ja kolo-

rem czarnym.

Dronoe || DRewd || X i s

R | W e |

28. Tak powinna wygladaé nasza paleta warstw:
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Krycie: ~ 4 1oog L
B obrys

] Ih.ll:lEE poswiats
RCH] PSS NOSE

S H] OS5 |Crop-Shadow

E Tho

29. Splaszczamy nasz obrazek "Obraz > Splaszcz ob-
raz".

Uff, tyle roboty a taki cieniutki efekt dopiero mamy,
ale najlepsze jest wlasnie przed nami :)

30. Zastosujemy teraz filtr "Filtry > Znieksztalcenia
> Wytloczenie". Teraz mamy bardzo duze pole do po-
pisu z ustawieniami tych trzech suwaczkow.

Jezeli "Wzniesienie" ustawimy na 90, to tlo pozosta-
nie biale, a warto$¢ ustawiona jako "Azymut" nie ma
zadnego wplywu na tloczenie.

Ja zastosowalem takie ustawienia:

Funkcja - Wytloczenie

Azymut: 90
Wzniesienie: 90
Glebia: 30
- [} [}
13 13
L L

Modyfikacje i inne wariacje:

Efekt podstawowy juz uzyskaliémy, lecz istnieja
ogromne mozliwoSci zmian efektu wyjéciowego.
Wszedzie, gdzie ustawia sie jakiekolwiek rozmycie
lub zmniejszenie zaznaczenia, wystarczy zmienic¢ war-
to§¢ parametru o 1px, a efekt koncowy bedzie
calkowicie inny.

Modyfikacja 1

Pierwsza modyfikacja jest zabawa na koncowym ob-
razku krzywymi "Warstwa > Kolory > Krzywe", przy-
kladowe ustawienie krzywej:

Kanat: | “Wartoéd * | | Zesetu] kanat

[ie]] | [}

Modyfikacja 2

Druga modyfikacja polega na zastosowaniu innych
ustawien w punkcie 30:

Funkcja - Wytloczenie

Azymut: 90

Wzniesienie: 135

Glebia: 40

A=

Ponownie uruchamiamy filtr "Wytloczenie" z przy-
kladowymi ustawieniami:

Funkcja - Wytloczenie

Azymut: 90

Wzniesienie: 135

Glebia: 40

Modyfikacja 3
Pomijamy punkty zwigzane z tworzeniem maski czy-
li 12-18 i dalej postepujemy wedlug harmonogramu.

Il
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Dodatkowo zastosowalem jeszcze sposoby z mody-

fikacji 2 i 1 taki blyszczacy chrom.
(ST =20 T o 1 =

Modyfikacja 4

Po prostu mozemy pokolorowaé nasz napis poprzez

"Warstwa > Kolory > Balans koloréw" lub "Warstwa
> Kolory > Barwienie".

Wariacje

Wariacje rozne robilem wczeéniej i tez sporo faj-
nych efektow uzyskalem na bazie tego tutorialu, lecz
nie bede juz ich tutaj opisywal, bo to jest inna bajka,
a wiekszos$ci fajnych z nich, niestety, nie zapisatem.

Pytania dotyczace tutorialu mozna kierowa¢ na ad-
res noss2@gmail.com
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